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About this Guide

Style Conventions

Document Conventions

Notes

7

Cautions

AN\

Warnings

Formatting conventions are used throughout this guide as a method of
providing consistency for notes, cautions, and warnings.

Notes appear throughout the manual to provide additional information
on a topic, including technical details, exceptions to instructions and
other pertinent information. These notes are identified by the notepad
symbol and bold italics text.

Cautions appear when there is information for the user that is strongly
recommended. They are identified by the exclamation mark in a triangle
and bold italics text. This text appears in gold bold italics text if the
user is viewing the manual in electronic PDF form on their computer.

Warnings appear when there is something of extreme importance for
the user to know prior to proceeding. They are identified by the
exclamation mark in a triangle and bold italics text. This text appears in
red bold italics text if the user is viewing the manual in electronic PDF
form on their computer.

Keys and Keystroke Conventions

Portable keys and keystroke conventions are used throughout this
manual to identify the difference between a key on the portable and
keystrokes input by the user. Brackets such as: <Scan> indicate a key on
a portable data terminal. Data or keystrokes entered by the user, and
filenames or directories are presented ina nonospaced typeface.

Vi

PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



Radio Frequency Interference

Radio Frequency Interference

This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including
interference that may cause undesired operation.

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la Classe A est confirme a la norme
NMB-003 du Canada.

This equipment has been tested and found to comply with the limits for
a Class A digital device, pursuant to Part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in
accordance with these instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from
which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for
help.

User’s Guide Vil
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About this Guide

Technical Support

PSC Website Technical Support

The most comprehensive source for technical support and information
for PSC products is the PSC website: www.pscnet.com. The site offers
product support, product registration, warranty information, answers to
frequently asked questions (product FAQs), product manuals, product
tech notes, software updates, patches, demos, and instructions for
returning products for repair.

Reseller Technical Support

Another excellent source for technical assistance and information is an
authorized PSC reseller. A reseller is directly acquainted with specific
types of businesses, application software, and computer systems and,
therefore, is in the best position to provide individualized assistance.

E-Mail Technical Support

If the solution to a technical support question is not available through
the PSC website or a local reseller, contact PSC technical support
directly via E-mail at TechSupport@pscnet.com.

Telephone Technical Support

For those without E-mail access, call toll-free in the USA 1 (800) 547-
2507 or (541) 683-5700 from outside the United States of America.

PSC Solutions Group

For advanced, cost-effective services, contact the PSC Solutions Group
(PSG) at (888) 583-3008 or (541) 683-5700 from outside the United
States of America, or psg@pscnet.com. You can also visit PSG’s webpage,
accessible at www.pscnet.com.

viii
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Introduction & Quick Start Guide

Overview

This manual contains complete information about using and
programming the PT2000 portable and TopGun module.

The manual contains the following sections:

Chapter 2, About the PT2000 and TopGun, provides a complete
overview of the portables, including descriptions of the keypad,
the display screen, and optional accessories. Read this chapter
before using the portable.

Chapter 3, Using the PT2000 and TopGun with PALPRO, contains
complete information about operating the portable, connecting it
to a host computer or terminal, and uploading data to the host.
Read this chapter before using the portable.

Chapter 4, Programming the PT2000 and TopGun, explains how to
customize the portable’s settings. Read this chapter to change the
default settings.

Chapter 5, Transferring Data With PSC Utilities, provides
information about software programs to transfer data between the
portable and a DOS PC, an IBM 3151 terminal, a UNIX
workstation, or a Macintosh computer. Read this chapter to
upload collected data.

Appendix A, Programming Parameters, contains ID numbers,
acceptable settings, and defaults for all programming parameters
for TopGun and the PT 2000. Refer to this chapter to change
settings in the portable.

Appendix B, Full Keyboard Support, includes tables listing Code 39,
ASCII, and mnemonic values to use in programming the
portables. Refer to this chapter when creating bar codes for
programming the portable.

PT2000™ & TopGun™
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Overview

e Appendix C, The TopGun Module, provides information about the
TopGun module. Refer to this chapter if the TopGun module is
separate from the PT2000 or to change the direction of the laser.

e Appendix D, The PT Dock, explains how to set up and use the
optional dock for the PT2000 or TopGun. Refer to this chapter
before using the dock for the first time or when connecting it to a
PC.

e Appendix E, Batteries, provides information about using alkaline
or nickel-cadmium batteries and about the lithium backup
battery installed in the portable. Refer to this chapter to replace
one type of battery with another in the portable.

e Appendix F, Connector Configurations, identifies pin assignments
for the connectors on the PT2000. Refer to this chapter to order
cables or make custom ones.

e Appendix G, Programming Bar Codes, contains bar codes for
scanning to set selected programming parameters. Use this
chapter to change settings in the portable.

e Refer to the Index to find specific topics in this user’s guide.

e About this Guide contains a section on Technical Support, which
provides information on technical assistance. Refer to this section
for help or technical assistance.

User’s Guide 3
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Introduction & Quick Start Guide

Getting Started Quickly

The PSC portable comes with an application named PALPRO loaded in
memory. PALPRO includes three useful data-collection programs for
using the PT2000 or TopGun without additional programming.

Follow the steps below to begin using the portable with PALPRO
immediately. Page references show where to find more information.
They are live links in the PDF (on-line portable document format)
version of this manual.

1

Fill out and return the registration card enclosed with the unit. If
there is a TopGun module, be sure to include both serial numbers
on the registration card.

To replace the installed alkaline batteries with a nickel-cadmium
battery pack, refer to Appendix E on page 115.

With a PT2000, attach a bar code scanner or magnetic stripe
reader by pushing its plug into the jack at the top of the PT2000.
Be sure the plug is firmly in place.

Turn the portable on by pressing the green 1/0 button.
If the portable has been customized, it may operate

differently. Check with a systems administrator for
instructions.

Press the ENTER key twice to accept the current date and time, or
if necessary, change the date and time settings. (Refer to page 19.)
Enter a password. (Refer to page 20.)

Press any function key to display the PALPRO Options menu.

To use the portable as a keyboard wedge, connect it to a PC or
terminal following the instructions on page 21.

PT2000™ & TopGun™
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Getting Started Quickly

9. Then select <F3> from the PALPRO Options menu. (Refer to
page 23.)
e When not using the portable as a keyboard wedge, press the
<F2> key to display the list of available applications, and
select the application to use. (Refer to page 26—page 29.)

The PT2000 or TopGun is now ready to begin collecting data. Enter
data with the TopGun module or another bar code scanner, a magnetic
stripe reader, or the keypad.

For information about uploading collected data from the portable to a
PC, refer to “Uploading Data to the Host PC,” starting on page 49.

User’s Guide 5
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About the PT2000 and TopGun

The PT2000

The PSC PT2000 is a rugged, handheld, portable data-collection
terminal that allows bar code scanning technology anywhere.

The PT2000 accepts input from any of the following devices:
e The TopGun module (refer to page 9)
e \Wands (visible light and infrared)
Handheld charge-coupled device (CCD) scanners
5-volt handheld laser scanners
ID badge readers
Magnetic stripe readers (one track)

The PT2000 automatically recognizes and discriminates among the
following bar code symbologies:

e Codabar e Code 128 e Code 39

® Code 93 ® EAN-8 ® EAN-13

® |Interleaved2 0of5 e JAN-8 ® JAN-13

e UPC-A e UPC-E ® UPC/EAN/JAN extensions

The PT2000 verifies acceptance of input by sounding a beep. Change
the beeper’s volume, pitch, and duration to suit the work environment
or personal preferences.

The PT2000 liquid crystal display (LCD) provides easy readability. Its
keypad provides full alphanumeric input capabilities and includes four
programmable function keys. The PT2000 features a built-in PC
interface, for use as a keyboard “wedge” for those applications requiring
fixed-station scanning.

The PT2000 comes with the PALPRO application installed. PALPRO
is made up of three useful programs coexisting in memory:

e ASSETPRO, for tracking assets at various locations.

e INVPRO, for inventory control. Customize it to collect item-
and-quantity information or item-only data.

8 PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



TopGun

7

TopGun

e TRACKPRO, for tracking check-in and check-out of articles at
one or more locations. An optional date-and-time stamp records
when each item is checked in or out.

PALPRO is part of the PSC Portable Applications Library (PAL). With
PAL, the PT2000 can be customized for specific purposes without using
a programming application. Or use the PSC Program Generator™
(PPG™) to create additional custom programs for the PT2000.

Note: Please contact a PSC dealer for more information about
PAL or PPG.

TopGun is an integrated unit consisting of a laser module mounted on a
PT2000. The TopGun module is also available separately as an add-on
for the PT2000 (refer to Figure 2-1 on page 10). The module attaches to
the 9-pin connector at the top of the PT2000 and can be adapted for
right- or left-handed use. The module has two triggers, allowing
scanning with either the index finger or thumb.

Use TopGun to scan bar code labels on flat, curved, or irregular surfaces
at distances ranging from one inch to two feet. The TopGun laser
module operates like other handheld lasers—just aim and press the
trigger. Light-emitting diodes (LEDs) on the module indicate laser
activation and good reads. An audible tone also indicates good reads.
Collected data is stored in the PT2000.

User’s Guide
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About the PT2000 and TopGun

For complete information about the TopGun module, refer to
Appendix C 0N page 99.

Figure 2-1: The TopGun Module

The Keypad

The keypads on the PT2000 and TopGun have three types of keys: data
keys, function keys, and action keys (refer to Figure 2-2 on page 11). Each
key produces a beep when pressed.

10 PT2000™ & TopGun™
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The Keypad

Figure 2-2: The PT2000 and TopGun keypads

Function keys

Action

Data kevs

Action keys

Data Keys
Use data keys to enter letters, numbers, and several other characters.
There are 26 of these keys. Each key can be used in two modes: normal
and alpha. Use the <Alpha> key to switch between the modes (see the
description of the <Alpha> key below).

User’s Guide 11
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About the PT2000 and TopGun

Function Keys

Action Keys

24

There are four function keys, <F1> through <F4>, at the top of the
keypad. Alpha mode changes these keys to <F5> through <F8>. Actions
assigned to the function keys are determined by the active program.

There are four action keys: <1/0>, <Alpha>, <BKSP>, and <ENTER>.

Note: If the portable does not power on when the <1/0> key is
pressed, replace the alkaline batteries or recharge the
battery pack (refer to Appendix E).

<I/0>: Press this key to turn the portable on and off. When turned on,
the portable beeps and returns to its previous location when it last shut
off. The portable does not beep when the <1/0> key is pressed to turn the
unit off. The <Alpha> key has no effect on the <1/0> key.

<Alpha>: Press the <Alpha> key to toggle between normal and alpha
modes. In normal mode, a press of a key either inserts the nonletter
character printed on or above the key or performs an action (for
example, clearing the entry or scrolling through the display). In alpha
mode, a press of a key inserts the letter printed on it.

The following example uses two keys to illustrate the difference between
alpha mode and normal mode:

12
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The Display Screen

Press the <Alpha> key to enter alpha mode. A caret (*) appears at the
cursor position in the display screen. The portable remains in alpha
mode until a function key is pressed, or until the <Alpha> key is pressed
again.

<BKSP=>: This is the backspace key. Press it to move the cursor one
place to the left and delete the character there.

<ENTER>: Press this key to enter the current data string and move to
the next programming command.

The Display Screen

The portable’s display screen can show 4 lines of text with up to 16
characters on each line. However, the unit can actually hold up to 24
lines of data with up to 80 characters on a line. Scroll the display to view
data that doesn't currently appear.

The Virtual Display

The portable’s display screen is like a window to a larger display area,
called the virtual display (refer to Figure 2-3 on page 14). Data longer
than 16 characters is placed in the virtual display while entering or
reading information. Information automatically carries over (or “wraps”)
to the next line if there are more than 80 characters in a line.

User’s Guide
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Figure 2-3: Virtual display vs. actual display

A

F1=NEXT F2=PRE

REC#11 OF 16
120850A30NVES274J400967629
F3=REV F4=EXI T

_ = «——Displ
F1=NEXT 'F2=PRE et by 16
RECH#12 OF 16 characters)

24lines | 120850A30NVES274J400984019
F3=REV F4=EXI T

F1=NEXT F2=PRE

REC#13 OF 16
120850A30NVES274J400942885
F3=REV F4=EXI T

- |
80 characters

Virtual
display

When the portable is in normal mode, scroll text through the display
screen by pressing the <A>, <B>, <C>, and <D> keys on the keypad.
When using these keys, the text in the virtual display remains in place
and the display screen changes perspective. The symbol printed above
each key indicates the direction in which the display screen moves over
the virtual display that key is pressed.

Moves the display screen up one line

Moves the display screen down one line

Moves the display screen left eight characters

Moves the display screen right eight characters

EL| ChER B
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The Beeper

The virtual display continues to maintain the latest 24 lines of data once
all lines of the virtual display are full. The oldest data is “pushed off the
top” as new data is added at the bottom.

Displaying Information about the Portable

Display information about the portable by scrolling the display screen
past the last character on a current line. Press the <D> key until the
version number is displayed. The display screen lists the system version
number and the amount of random-access memory installed (refer to

Figure 2-4).

Figure 2-4: Display screen showing version number

PT2000
Vers. 4.0 128k

The Beeper

The portable provides audible feedback to indicate when a bar code has
been scanned successfully and to acknowledge when a key is pressed.
The default setting provides one beep to indicate a good scan or key
entry. Another beep sequence warns of possible problems. The pitch,
number, volume, and length of beeps are all programmable.

User’s Guide
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The Auto-Off Feature

The Auto-Off feature lets the PT2000 or TopGun conserve power by
partially shutting down when not in use. Pressing the <i/0> key returns
the portable to full power. Set the time between the last activity in the
portable and Auto-Off from 1 through 99 minutes. The default is 10
minutes. A setting of 00 disables Auto-Off.

The PT Dock

The PSC PT Dock™ (refer to Figure D-1 on page 109) is specially
designed for use with the PT2000 and TopGun. The dock provides a
connection between the PT2000 or TopGun and the PC without
sacrificing the convenience of portability. To transmit data to or from
the portable, place the unit in the dock. To use the PT2000 or TopGun
for data collection again, remove it from the dock. Or, use the PT Dock
to recharge the portable’s rechargeable NiCd battery pack and backup
lithium battery.

For more information about the PT Dock, refer to Appendix D, The PT
Dock.

16
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Using the PT2000 and
TopGun with PALPRO

Use the PT2000 or TopGun as a keyboard wedge to enter data directly into an application
one item at a time. When away from the PC, it is possible to collect all the data records and
upload them to the host PC later. The number of data records that can be collected before
uploading them depends on how much random-access memory (RAM) the portable has.
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Using the PT2000 and TopGun with PALPRO

Getting Started

Unless it has been customized, the PT2000 or TopGun has three
alkaline batteries installed and is programmed for simple data collection.
To begin using the portable, attach the input device (PT2000 only; refer
to Attaching an Input Device to the PT2000, below) and turn it on.

original PSC programming (PALPRO). If the portable has
been customized, it may operate differently. Check with a
systems administrator for revised operating instructions.

7 Note:  This chapter describes how to use the portable with its

Attaching an Input Device to the PT2000

The PT2000 can be used with most industry-standard input devices
equipped with a 9-pin squeeze connector.

Bar Code Attach a bar code scanner by pushing its connector into the connector at
Scanner the top of the PT2000. Be sure the scanner connector is firmly in place.
Refer to the input device’s operating manual for instructions on its use.

Magnetic To attach a compatible1 magnetic stripe reader (MSR) complete the
Stripe Reader following steps:

1. Remove the black plastic welp clip from the connector on the top
of the PT2000 (refer to Figure 3-1).

2. Using a flat-blade screwdriver, remove the two screws securing the
clip, and pull the clip off the connector.

3. Push the MSR’s connector into the PT2000’s connector.
e Be sure the MSR connector is firmly in place.

1.0nly the following M SRs can be used for this purpose:
00-000-2A (Track 1), 00-000-2B (Track 2) or 00-000-23 (Track 3).

18 PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



Getting Started

Figure 3-1: The input connector on the PT2000

Welp clip

Turning On the Portable
Turn the PT2000 or TopGun on by pressing the green <i/0> button.
l ,l"D The display screen returns to the view displayed when it was turned off.

Setting the Time and Date

Figure 3-2: The Time and Date Display

Current Date:

02/ 01/ 02

Ent er New Dat e:

o]
When turning the portable on for the first time, the display screen
shows the date currently loaded in memory. If the displayed date is
correct, press the <ENTER> key. If the date is wrong, enter the correct
date. Use two digits each for the month, for the day, and for the year
(e.g., 020101). Press <eNTER> for the program to automatically format
the entry (e.g., 2/ 01/ 01).

Figure 3-3: The Current Time Display

Current Ti me:

09:17: 32

Ent er New Ti ne:

o}
The next display screen shows the time currently loaded in the portable’s
memory. If the displayed time is correct, press the <ENTER> key. If the
time is wrong, enter the correct time. Use two digits each for the hour,
for the minute, and for the seconds (e.g., 133000). If the portable’s

User’s Guide 19
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Using the PT2000 and TopGun with PALPRO

system clock is set for 12-hour format, type Afor A.M. or P for .M. after
the number (e.g., 013000P). Press <eNTER> when finished.

other display screens and menus (such as the password
prompt screen shown below). Or, change the date and time

7 Note: It is possible to return to the date and time prompts from
formats (refer to page 67).

Setting a Password

Figure 3-4: The Password Display

ENTER CURRENT
OR NEW PASSWORD

o}

F- KEY=SET TI ME

Password security allows a manager or supervisor to customize a portable
and then hand it off to a worker. A password can contain up to 128
characters and can use any characters available on the portable. Without
the password, the worker cannot switch applications or make changes to
an application’s title or prompts. The password prompt screen appears
after entering the date and time from a reset.

Note: If a password is lost or forgotten, reset the portable and start
I over with a new password.

Figure 3-5: PALPRO Options Menu

PSC PALPRO
08:18: 04~

03/ 01/ 98

F- KEY=CONTI NUE

After the password is entered, the text in Figure 3-5 is displayed. Press a
function key (any of the blue keys at the top of the keypad), for the
display to change to the PALPRO Options menu. The portable is now
ready to collect data.

20 PT2000™ & TopGun™
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Collecting Data

Collecting Data

When finished setting up the PT2000 or TopGun (refer to the previous
section), the PALPRO Options menu appears on the display screen. Use
the menu to choose a PALPRO application or use the portable as a
keyboard wedge.

Using the Portable as a Keyboard Wedge

With the PT2000 or TopGun attached to the PC or IBM 3151 terminal
as a keyboard wedge, use a bar code label or magnetic stripe to enter data
directly into the application. Data can also be entered by using the
keypad on the portable.

Installing the Two PSC cables® are required to install the portable as a keyboard
Keyboard wedge.

Wedge T4 connect the PT2000 or TopGun as a keyboard wedge, complete the

following steps:

1. Plug the 15-pin connector into the cable connector on the
bottom of the portable.

Figure 3-6: Keyboard wedge installation for PCs

L

I
G A .

—
i Vil ||l'| I"
-
™,

\%%Eﬂ%

1.For a listing of PT2000 cable numbers, consult the PSC Price Book at:
http: www.pscnet.com.
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Using the
Keyboard
Wedge

Figure 3-7:

30-286,50,507, 60,
70, 80,90, 95 (U.S.
keyboard)

AT or PS/2 models ‘"H

IBM 3151 terminal ‘"H

Attach the other end to the 25-pin connector of the keyboard
wedge cable (refer to Figure 3-6 on page 21).

PC: Attach the small male plug of the PSC cable to the keyboard
jack on the PC (refer to Figure 3-6).

Terminal: Insert the keyboard cable plug into the modular jack
on the PSC cable connector.

PC: Attach the keyboard cable to the small female jack on the
PSC cable (refer to Figure 3-6).

Terminal: Insert the modular plug of the PSC cable into the
keyboard input jack on the terminal.

Scan the appropriate bar code below:

-DbD2cC®811ETE »
- D2C®w®15EE =»

+

To use the PT2000 or TopGun as a keyboard wedge, complete the setup
and installation procedures described earlier in this chapter. Then
complete the following steps:

From the PALPRO Options menu, select <F3>.

The PALPRO Options Menu

PALPRO OPTI ONS
F2=SELECT PROG
F3=WEDGE
F4=PASSWORD=

Open the application and place the cursor at the location where
the data is to be entered.

22
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3. Use a bar code scanner (the TopGun module or another device
attached to the PT2000), a magnetic stripe reader, or the keypad
to enter data.

e When scanning a bar code or running a magnetic stripe card
through the reader, the data is entered at the cursor position
in the application.

e When using the keypad to enter the data, the data is
displayed in the second line of the PT2000 display screen.

e Press the <eNTER> key, to send the data to the PC.

4. When finished collecting data, press the <F5> key
(<Alpha>+<F1>) to exit.

Figure 3-8: The PT2000 Wedge Menu
* PT2000 WEDGE *

o}

FS=EXI T

Using PALPRO

PALPRO combines three Portable Applications Library applications into
a single, convenient program (refer to page 8). With PALPRO installed
on the PSC portable, it is possible to switch from one application to
another without having to install each application.

Selecting a Complete the following steps to select a PALPRO application:
PALPRO
Application

Figure 3-9: The PALPRO Options Menu

PALPRO OPTI ONS
F2=SELECT PROG
F3=WEDGE
F4=PASSWORD®=

1 With the PALPRO Options menu displayed, press the <F2> key.

User’s Guide 23

Download from Www.Somanuals.com. All Manuals Search And Download.



Using the PT2000 and TopGun with PALPRO

2. Press <F1>t0 use ASSETPRO, <F2> t0 Use INVPRO, Or <F3> to use
TRACKPRO.

Figure 3-10: Selecting a PALPRO application
F1=ASSET MaMI

F2=I NV MaMr
F3=I TEM TRACKI NG
FA=EXI T=

one or two prompts (refer to page 29 for information). Make

7 Note: If INVPRO is selected, the next screen asks the user to select
I a selection before going on to the next step.

3. To change the application’ title or prompts, select <F3>.
Otherwise, select <F4>,
Figure 3-11: Changing Prompts Menu
CHANGE PROMPTS?
F3=YES
F4=NOr

e When finished changing prompts (or if <F4> was selected in
step 3), the selected application’s menu appears on the
portable’s display screen.

e For information about using the individual applications, refer
10 page 27—page 29.

Changing Program Titles and Prompts, below.

7 Note: For information about changing titles and prompts, refer to

adding a date/time stamp before getting to the application

7 Note: If TRACKPRO was selected, the user is given the option of
I menu. (Refer to page 33.)
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Changing PALPRO allows the user to change the title that appears on the menu for
Program each application, or change the prompts for each application. Change
Titles and titles or prompts after selecting an application. To use the application’s
Prompts current title and prompts, select <F4> at the prompt shown at the left.
To change the title or prompts, complete the following steps:
1 Press the <F3> key at the prompt.
Figure 3-12: Changing Prompts Menu
CHANGE PROMPTS?
F3=YES
F4=NOr
2. Enter a name for the application (for example, FI XED ASSETS)
followed by the <ENTER> key. The entered name appears at the
top of the application menu for the current application.
Figure 3-13: Changing the Title
ENTER APPL TI TLE
FI XED ASSETS=
3. Enter the text for the first prompt (for example, BUI LDI NG | D)
followed by the <ENTER> key.
Figure 3-14: Entering the First Prompt
ENTER PROMPT 1
BUI LDI NG | D=
4. Enter the text for the second prompt (for example, ASSET NO. )
followed by the <ENTER> key.
User’s Guide 25
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Figure 3-15: Entering the Second Prompt

ENTER PROVPT 2
ASSET NO. =

Switching to To switch from one PALPRO application to another, complete the
Another following steps:
PALPRO

.. 1. Select <F5> from the current application’s menu to exit the
Application

application.

Note: Enter <F5> on the keypad by pressing the <Alpha> key and
then the <F1> key.

Figure 3-16: Application Menu

ASSET MGMIe
F2=COLLECT
F3=FI LE OPTI ONS
FS5=EXIT

2. At the prompt, enter the current password, or press any function
key (the blue keys at the top of the keypad) to return to the menu
for the current application.

Figure 3-17: Password Prompt
ENTER PASSWORD
o]

F- KEY=EXI T
3. When the correct password is entered, the original PALPRO
screen appears.

4. Press any function key to display the PALPRO Options menu.

5. Follow the steps under Selecting a PALPRO Application ON page 23.
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Using Use ASSETPRO to track assets (furniture, phones, computers, electronic
ASSETPRO equipment, etc.) at various locations (example: departments, rooms,
floors, buildings, etc.). With ASSETPRO, enter an identification code
for a location, collect all the asset IDs at the location, and then enter an
identification code for a different location.

To use ASSETPRO, complete the following steps:

1 From the ASSETPRO application menu, select <F2>.
Figure 3-18: ASSETPRO Application Menu

ASSET MGMT @
F2=COLLECT
F3=FI LE OPTI ONS
FA=EXI T
2. The first prompt appears on the screen. Enter the identification
code for the location (example, WH3E).
e Scan a bar code for the location or use the keypad to enter the
location ID.
e When using a scanner, the code is entered automatically;
when using a keypad, press the <ENTER> Kkey.

Figure 3-19: The Location ID Prompt
LOCATION I D

o}

F3=REV F4=EXIT
3. The second prompt now appears on the first line of the screen,
and the location ID appears on the third line.
e Scan the bar code identifying an asset, or use the keypad to
enter the asset’s ID number or description (for example,
004322).
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Figure 3-20: The Item ID Prompt

| TEM I D

o]

VWH3E

F3=REV F4=EXI T
The location ID and item 1D appear together on the third line of
the screen, separated by a comma, and the second prompt remains
on the screen.
e The portable is ready to accept another ID for an asset at the

current location.

Figure 3-21: The Next Item ID Prompt

7.
8.

| TEM I D

a
VWH3E, 004322
F3=REV F4=EXI T

When finished collecting asset 1Ds for the location, press the <F4>
key to return to the first prompt.

Repeat steps 2-5 until IDs for each asset at every location is
collected.

Press the <F4> key to return to the first prompt.

Press the <F4> key to return to the application menu.

The portable stores the collected data in a single ASCII text file. When
uploading the file to the PC, the data appears as a list. Each line in the
list contains two fields separated by a comma. The first field is the
location, and the second field is the equipment identification number.
The example in Figure 3-22 is part of a data file uploaded from a
portable that used ASSETPRO to collect data.
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Figure 3-22: Collected Data in ASCII text file

BLDGL, 000295
BLDGL, 001862
BLDGL, 000945
BLDGL, 001008
BLDGL, 000036
BLDGL1, 000490
BLD&2, 000288
BLD&2, 002596

Using Use this application to track inventory. INVPRO provides a choice of one
INVPRO prompt or two. Use one prompt to scan or enter an ID number or
description for each item. Use two prompts to scan or enter an item 1D
and the quantity of that item.

To use INVPRO, complete the following steps:

1. Atthe first screen that appears, press the <F4> key to use the
application with only one prompt.
e Use the <F3> key for two prompts.

Figure 3-23: Selecting the Number of Prompts
USE 2 PROWPTS?
F3=YES
F4=NO=
2. Press the <F3> key to change the title or prompts that appear on

the application’s display screens. (Refer to page 25 for instructions
on changing the prompts.)

Figure 3-24: Changing Prompts
CHANGE PROVPTS?
F3=YES
F4=NOr=
e To use the current title and prompts, press the <F4> key.
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3. The application menu appears next on the display screen.

4. Continue with the instructions for Using One Prompt, below, or
Using Two Prompts 0N page 31, depending on the selection made
in step 1.

Using One Prompt

1. Select <F2> from the application menu.
e A prompt appears on the screen.

2. Scan the bar code for an inventory item, or use the keypad to
enter the item’s ID number or description.
e Using a scanner, the code is entered automatically; with a
keypad, press the <ENTER> Kkey.

3. The item ID number appears on the third line of the screen. The
portable is ready to accept another item ID.

Figure 3-25: The Item ID Display
| TEM | D

o}
40- 000- 00
F3=REV F4=EXI T
4. Repeat step 1 until all IDs for all items are collected.

5. Press the <F2> key to return to the application menu.

The portable stores the collected data in a single ASCII text file. When
uploading the file to the PC, the data appears as a list. Each line in the
list contains the ID for a single item. The example in Figure 3-26 is part
of a data file uploaded from a portable that used INVPRO with one
prompt to collect data.
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Figure 3-26: Collected Data in ASCII text file
40- 000- 00
40- 002- 00
40- 006- 00
40- 010- 00
00- 000- 17
00- 000- 19
00- 000- 02
00- 000- 11

Using Two Prompts

1 Select <F2> from the application menu. The first prompt appears
on the screen.

Figure 3-27: The Item ID Display
| TEM | D

o}

F3=REV F4=EXI T
2. Scan the bar code for an inventory item, or use the keypad to
enter the item’s ID number or description.
e Using a scanner, the code is entered automatically; with a
keypad, press the <ENTER> key.

Figure 3-28: Enter the Number of Units of Item in Inventory
QUANTI TY
a
40- 000- 00
F3=REV F4=EXI T

3. The second prompt now appears on the first line of the screen,
and the item 1D appears on the third line.

4.  Enter the number of individual units of the item in inventory.

5. The item number and quantity appear together on the third line
of the screen, separated by a comma, and the first prompt
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Figure 3-29:

Figure 3-30:

Using
TRACKPRO

reappears on the screen. The portable is ready to accept another

item ID
Input Another Item ID
| TEM | D
o]
40- 000- 00, 25

F3=REV F4=EXI T

6. When finished collecting inventory data, press the <F4> key to
return to the application menu.

The portable stores the collected data in a single ASCII text file. When
uploading the file to the PC, the data appears as a list. Each line in the
list contains two fields separated by a comma. The first field is the item
ID, and the second field is the number of units of that item. Figure 3-30
shows part of a data file uploaded from a portable that used INVPRO
with two prompts to collect data.

Collected Data in ASCII text file

40- 000- 00, 25
40- 006- 00, 12
00- 000- 19, 56
00- 000- 02, 30
40- 002- 00, 47
00- 000-17, 16
40-010-00, 4

00- 000- 11, 85

Use this application to record check-in and check-out of articles
(supplies, books, files, tools, equipment, etc.) at one or more locations.
TRACKPRO uses two prompts, one for location and one for item,
looping at the second prompt until the user exits to record a new
location 1D An optional date/time stamp records exactly when each item
is taken or returned.

To use TRACKPRO, complete the following steps:
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1. Atthe first screen, press the <F3> key to change the title or
prompts that appears on the application’s display screens. (Refer
to page 25 for information on changing the prompts.)

Figure 3-31: The Change Prompts Display
CHANGE PROWPTS?

F3=YES
F4=NOa

e To use the current title and prompts, press the <F4> key.
2. At the next prompt, select <F3> to use the date/time stamp.

Figure 3-32: The Add Date/Time Stamp Display

ADD DATE/ TI ME
STAVP?
F3=YES
F4=NOa

e Otherwise, select <F4>.
Figure 3-33: The Item Tracking Display

| TEM TRACKI NG=
F2=COLLECT

F3=FI LE OPTI ONS
FS=EXIT

3. From the application menu, select <F2>.
Figure 3-34: The QUANTITY Display

F1=CHECK I N
F2=CHECK OUT
F4=EX| To

4, Press the <F1> key to record an item being checked in.
e Press <F2> to record an item being checked out.

5. Enter the identification code for the location (for example,
MAI N).
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6. Scan a bar code for the location or use the keypad to enter the ID
code.

Figure 3-35: The Location ID Code Display
LOCATION I D
o}

IN :
F3=REV F4=EXI T
e With a scanner, the code is entered automatically; with a
keypad, press the <ENTER> key.

7. The ITEM ID prompt appears on the first line of the screen, and
the location 1D appears on the third line.

8. Scan the bar code for the item, or use the keypad to enter the
item’s ID number or description (for example, P203).

Figure 3-36: The ITEM IDDisplay
I TEM I D

o]

IN : MAIN
F3=REV F4=EXI T
9. Thelocation ID and item ID appear on the third line of the
screen, separated by a comma. The ITEM ID prompt remains on
the screen, and the portable is ready to accept another ID for an
item at the current location.

Figure 3-37: The Next ITEM ID Display
| TEM | D

o]
I N : MAI N, P203
F3=REV F4=EXI T

Note: If the application is set up to add a date/time stamp, the
P’ date and time that the item was checked out will follow the
I item ID on the third line. (Scroll the display to see the entire

T line.)
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10. When finished collecting asset 1Ds for the location, press the <F4>
key to return to the LOCATION ID prompt.

11. Repeat steps 5 through 10 until all the IDs for the assets at every
location are collected.

12. Press the <F4> key again to return to the menu shown at step 4.

13. To change from check-in to check-out (or vice versa), repeat

step 4.
e Otherwise, press the <F4> key to return to the application
menu.

The portable stores check-in data in one ASCII text file and check-out
data in another file. When uploading one of the files to the PC, the data
appears as a list. Each line in the list contains two fields separated by a
comma. The first field is the LOCATION ID, and the second field is the
ITEM ID When using the date/time stamp, each line also includes the
check-in or check-out date and time. The list shown in Figure 3-38 is
part of a check-out file uploaded from a portable that used TRACKPRO
with the date/time stamp.

Figure 3-38: Collected Data in ASCII text file

MAI N, P203, 03/ 01/ 98, 10: 27: 18

MAI N, 814223- 001, 03/ 01/ 98, 10: 27: 45
MAI N, 00- 929- 00, 03/ 01/ 98, 11: 04: 51
MAI N, P0009222, 03/ 01/ 98, 11: 22: 02
WHS, 00- 680- 00, 03/ 01/ 98, 11: 40: 53
WHS, 004322, 03/ 01/ 98, 11: 40: 57

WHS, 16- 000- 00, 03/ 01/ 98, 11: 41: 11
WHS, A0039242, 03/ 01/ 98, 11: 41: 15

DESCRIPT
DESCRIPT (The Description Application) is another useful program for
tracking inventory. You can use the application with item and
description files that you create and load in advance. You can also add
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to files or create them from scratch in the portable as you collect
inventory data.

When you enter an item ID into the portable, the application checks the
loaded item file for that entry. If the ID matches one in the file, the
portable displays a description of the item (which it gets from the loaded
description file) and prompts you for the number of individual units of
the item. If the ID does not match one in the item file, the application
allows you to add the ID and a description to the database.

The item and description files are simple ASCII text files consisting of
singles lines of data. The lines in the two files correspond to each other;
that is, the first line in the description file is the description of the item
in the first line of the item file, the second line in the description file is
the description of the item in the second line of the item file, and so on.
Examples of the two types of files are shown below. The item file is on
the left, and the description file is on the right.

00-629-02 PT DOCK MANUAL
00-667-00 PT2000 MANUAL
00-670-00 S10+ MANUAL
00-675-00 S20+ MANUAL
00-680-00 EASYWAND MANUAL
00-690-00 BC BASICS MANUAL
00-693-00 TOPGUN MANUAL
1-697-0 EASYKEY+ MANUAL

Note:  The two files must have exactly the same number of lines,
even if some of the lines are blank.
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Loading Item and Description Files into the Portable

computer, see the user’s guide for the portable. For
information about PTFER and PDTFER file-transfer
programs, see pages 73-80.

7 Note: For information about connecting a portable to your

1. At the screen displaying the program name, press any function

key.
Figure 3-39: DESCRIPT Prompt
DESCRI PT
08:17: 321
05/ 01/ 02

F- KEY=CONTI NUE
2. At the next screen, press the <F1> key to display the application

menu.
Figure 3-40: Selecting DESCRIPT
F1=DESCRI PT
F2=WEDGE
FA=EXI TR

Note: For information about using the portable as a wedge, see
I “Using the Portable as a Keyboard Wedge” on page 21.

3. From the application menu, select <F2>.

Figure 3-41: DESCRIPT Application Menu
F1=COLLECT
F2=RECEI VE LI STS
F3=FI LE OPTI ONS
FA=EXI TH

4. Ifitem and description lists are already loaded in the portable, the
screen shown at the right will be displayed. To replace a list, select
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<F2>and go to step 5. To add new items to an existing list, select
<F3> and go to step 8.

Figure 3-42: FILE NOT EMPTY Prompt
FI LE NOT EMPTY
F2=ERASE
F3=APPEND
FA=EXI TR

5. To erase the item and description lists that are currently loaded in
the portable, select <F2>. The second line of the display screen
will become blank, and the lists will be removed from the
portable’s memory.

Figure 3-43: ERASE Option
ERASE
F2=PI CKLI ST
F3=COLLECT
FA=EXI TR

6. Press the <F4> key to return to the application menu, and select
<F2>,

7. From the Receive Lists menu, select <F2> to download the item
list or <F3> to download the description list.

Figure 3-44: RECEIVE LISTS Menu

RECEI VE LI STS

F2=RECEI VE | TEM

F3=RECEI VE DESC

FA=EXI TR

8. The next screen will prompt you to connect the portable to the

computer. When you are sure the portable is connected properly,
run the appropriate transfer program to download the list. (Use
PTFER in Windows or PDTFER in DOS). Then select <F3> on
the portable to transfer the file.
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Figure 3-45: CONNECT TO PORTABLE Prompt
CONNECT FOR REC
| TEM LI ST
F3=CONTI NUE
FA=EXI Th

9. When the transfer is completed, the portable’s screen will report
on the number of records in the list in memory. Press the <F4>
key to return to the Receive Lists menu.

Figure 3-46: Results Report
RESULTS
RECORDS=1611
F4=CONTI NUE
10. To load another file, repeat steps 7 through 9. When both files
are loaded, press the <F4> key to return to the application menu.

Using
DESCRIPT

I P Note:  To set a new date or time, see page 19.

1. At the screen displaying the program name, press any function

key.
Figure 3-47: DESCRIPT Prompt
DESCRI PT
08:17: 321
05/ 01/ 02

F- KEY=CONTI NUE

2. At the next screen, press the <F1> key to display the application
menu.
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Figure 3-48: Selecting DESCRIPT
F1=DESCRI PT

F2=\\EDGE
F4=EXI T

Note:  For information about using the portable as a wedge, see the
user’s guide for the portable.

3. From the application menu, select <F1>.

Figure 3-49: DESCRIPT Application Menu

F1=COLLECT

F2=RECEI VE LI STS

F3=FI LE OPTI ONS

FA=EXI TR

4. The screen prompts you for an item identification. Scan the bar

code for an item, or use the keypad to enter the item’s ID number
or description (for example, 00-693-00). (If you use a scanner,
the code is entered automatically; if you use the keypad, you must
press the <ENTER> key).

Figure 3-50: ITEM ID Prompt
| TEM | D

00- 693- 00N

F3=REV F4=EXIT
5. If the item ID matches an ID in the next item file, the portable
displays the text from the corresponding line in the description
file and prompts you for the number of units of the item.
If there is no match for an item ID, the portable prompts you to
reenter the item 1D or add it to the item list. To add an item to
the list, press the <F3> key.
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Figure 3-51: ITEM ID Match
QUANTI TY

|
BCBASI CS MANUAL
F3=REV F4=EXI T

The application adds the item ID to the item list and prompts
you for a description of the item. Use the keypad to enter a
description (for example, POCKET READER MANUAL). The
application will add the description to the description file and
prompt you for the number of units of the item.

Figure 3-52: Entering Item Description
ENTER DESCRI PT

6.  When you enter a number (for example, 50), the portable returns
to the first prompt, ready to accept another item ID

7. When you are done collecting inventory data, press the <F4> key
to return to the application menu.
The portable stores the collected data in a single ASCII text file.
When you upload the file to your computer, the data will appear
as a list. Each line in the list will contain two fields separated by a
comma. The first field is the item 1D, and the second field is the
number of units of that item. (The item descriptions are not
included in the file). The list below is part of a data file uploaded
from a portable that used DESCRIPT to collect data.

00-680-00, 46
00-667-00, 244
00-697-00, 90
00-693-00, 135
00-675-00, 19
00-629-02, 72
00-670-00, 159
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INVMODEM

2

Using the
Modem
Feature

2

Figure 3-53:

INVMODEM (Inventory Application with Modem Option ) works
exactly like INVPRO. However, an additional feature lets you send the
collected data to a computer over a modem.

To use this application, you should have experience with modem
communications. You should know how to set up the modem for your
system and how to use the communications software that runs it. If you
are connecting to a bulletin board system, you should know how to log
into the system.

Note: For information about using the application, see page 29.

Note:  The modem should be set up for transmission at either 2400
or 9600 baud with no parity, 8 data bits, 1 stop bit, and no
date compression. INVMODEM uses Xmodem protocol for file
transmissions.

1. From the application menu, select <F3> for file options.

INVMODEM Application Menu
I NV W MODEM
F2=COLLECT
F3=FI LE OPTI ONS
FA=EXI TR

2. From the File Options menu, select <F2>.
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Figure 3-54: Select SEND FILE

*FI LE OPTI ONS*
F2=SEND FI LE
F3=ERASE FI LE
FA=EXI Th

3. Use a cable supplied by your PSC dealer to connect the portable
to your modem, and select <F3> from the send file menu.

Figure 3-55: Select MODEM

*SEND FI LE*
F2=SERI AL
F3=MODEM
FA=EXI TI

4. Select <F2> to transmit the file at 2400 baud or <F3> to transmit
it at 9600 baud.

Figure 3-56: Select BAUD RATE

SELECT BAUD RATE

F2=2400, N, 8, 1

F3=9600, N, 8, 1

FA=EXI TR

5. Enter the telephone number to dial. Be sure to use the format

that your modem requires. (For example, you may need to use
"9," as a prefix for the number). When you press the <ENTER>
key on the keypad, the application connects to the modem and
calls the number.

Figure 3-57: Entering the telephone number

NUMBER TO DI AL
|

FA=EXI T

6.  When the modem connects to the remote computer, two-way
communications between the portable and the computer is
established. Use the portable to enter the commands you need to
prepare the computer to receive a file.
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7. When the computer is ready, press the <F3> key on the portable
to begin the file transmission.

Figure 3-58: Begin File Transmission

[
F3=UPLD F4=EXI T

8.  When the transmission is completed, the application displays a
message. Select <F4> to return to the previous screen.

Figure 3-59: Return to Previous Screen
UPLCAD COMPLETE

FA=EXI TQ

9. Select <F4> to hang up the modem and return to the application
menu.

TIMESTMP

TIMESTMP (The Time-Stamp Application) is a simple item-tracking

program that records the date and time that each item is entered into the
portable.

Using 1 At the screen displaying the program name, press any function
TIMESTMP key.

Figure 3-60: TIMESTMP Application Menu
TI MESTMP
08:17: 321
05/ 01/ 02
F- KEY=CONTI NUE

2. At the next screen, press the <F1> key to display the application
menu.
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Figure 3-61:

2

Figure 3-62:

Figure 3-63:

Figure 3-64:

TIMESTMP Menu
F1=TI ME STAWP
F2=WEDGE
F3=SET TI ME
FA=EXI TI

Note:  For information about using the portable as a wedge, see
“Using the Portable as a Keyboard Wedge” on page 21.

3. From the application menu, select <F2>.

Select COLLECT

TI ME STAMP

F2=COLLECT

F3=FI LE OPTI ONS

FA=EXI TR

4. Scan the bar code for an item, or use the keypad to enter the

item’s ID number or description (for example, 00-693-00). (If
you use a scanner, the code is entered automatically; if you use the
keypad, you must press the <ENTER> key).

Enter the ITEM ID
| TEM | D
00- 693-00R

F3=REV F4=EXI T
The item ID appears on the third line of the screen, followed by
the date and time, and the portable is ready to accept another
item ID

Enter Additional ITEM IDs
| TEM | D
[ |
00- 693- 00, 05/ 01/
F3=REV F4=EXI T

5. Repeat step 4 until you have collected IDs for all items. Then
press the <F4> key to return to the application menu.
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Changing the

Date and

Time Setting

Figure 3-65:

Figure 3-66:

The portable stores the collected data in a single ASCII text file.
When you upload the file to your computer, the data will appear
as a list. Each line in the list will contain the 1D for a single item,
followed by the date and time that the item ID was entered in the
portable. The list below is part of a data file uploaded from a
portable that used TIMESTMP to collect data.

40-000-00, 05/01/95, 10:27:18
40-002-00, 05/01/95, 10:27:45
40-006-00, 05/01/95, 11:04:51
40-010-00, 05/01/95, 11:22:02
00-000-17, 05/01/95, 11:40:53
00-000-19, 05/01/95, 11:40:57
00-000-02, 05/01/95, 11:41:11
00-000-11, 05/01/95, 11:41:15

1. From the application menu, select <F3>.

TIMESTMP Application Menu

F1=TI MESTMP

F2=W\EDGE

F3=SET TI ME

FA=EXI TR

2. If the displayed date is correct, press the <ENTER> key. If the date

is wrong, enter the correct date. Use two digits each for the
month, for the day, and for the year (e.g., 11, 04, 95). The
program will automatically format the entry (e.g., 11/04/95).

Entering the Correct Date
CURRENT DATE

05/ 01/ 02
ENTER NEW DATE:
|

3. If the displayed time is correct, press the <ENTER> key. If the
time is wrong, enter the correct time. Use two digits each for the
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hour, for the minute, and for the seconds (e.g., 133000). If the
portable’s system clock is set for 12-hour format, type A for A.M.
or P for P.M. after the number (e.g., 013000P).

Figure 3-67: Entering the Correct Time
CURRENT TI ME
8:17: 32
ENTER NEW TI ME:
[

Reviewing the Collected Data

Before uploading collected data, review it on the portable and delete
incorrect or unnecessary records.

Note: When used as a keyboard wedge, the portable does not store
any data.

1 From any screen that offers REV as an option, select <F3> to
display the data-review screen (refer to Figure 3-69).

Figure 3-68: Sample Screen Showing the REV Option
| TEM | D
o]
F3=REV F4=EXI T

e The last data that was input is displayed on the third line of
the screen.
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e If the record includes a quantity, the quantity is given after a
comma at the end of the line.

e The second line of the data-review screen tells the number of
the currently displayed record and the total number of
records. The top line of the data-review screen offers options
for moving through the records in memory.

Figure 3-69: Data-review screens

F1=PREV F2=NEXT F1=PREV F2=NEXT
REC#65 OF 65 REC#65 OF 65
27-000-00 27-000- 00, 15
F3=DEL F4=EXI T F3=DEL F4=EXI T
Item-only data Iltem-and-quantity data

2. Press the <F2> key to move to the next record.
e If the currently displayed record is the last one, the portable
will briefly display END OF FILE on the second line.

3. Press the <F1> key to move to the previous record.
e If the currently displayed record is the first one, the portable
will briefly display START OF FILE on the second line.

4. The bottom line of the screen offers options for deleting records
and returning to the data-collection screen.
e To delete the currently displayed record, press the <F3> key.
The message ARE YOU SURE? appears on the first line of the
screen.
e To delete the record, press <F3> again; to cancel, press <F4>.

5.  When finished reviewing the data records, press <F4> once to
return to the data-collection screen or twice to return to the
application menu.
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Uploading Data to the Host PC

The PT2000 and TopGun store data records in files in random-access
memory (RAM). When finished collecting data in a file, transmit
(upload) that file from the portable to the host PC. The number of
records that can collected before uploading depends upon the amount of
RAM the portable has.

Note: Refer to Appendix D on page 107 for instructions to connect
I the PT Dock to a PC.

The portable can be connected to the host PC in either a serial
configuration or a keyboard wedge configuration. The serial
configuration requires a communications program to transfer data to
and from the portable. With this configuration, use an external 9-volt
power adapter (available from a PSC dealer). With the keyboard wedge
configuration, power is drawn from the host PC.

Serial Configuration

Use a PSC 25-pin cable or a PSC 9-pin cable for serial configuration.

of PT2000 cable numbers, consult the PSC Price Book at:
http: www.pscnet.com.

7 Note:  Only use cables approved for this application. For a listing

Complete the following steps to attach the cable:

1. One of the connectors on the cable has the cable number on it.
Plug that connector into the cable input jack on the bottom of the
portable.

2. Attach the other end of the cable (with the connector labeled
computer) to an available serial port on the PC.

User’s Guide 49

Download from Www.Somanuals.com. All Manuals Search And Download.


http://www.pscnet.com

Using the PT2000 and TopGun with PALPRO

7

3. To use a 9-volt power adapter, attach the small, round plug of the
adapter to the round power input jack on the cable connector
labeled computer.

4. Plug the other end into an outlet or power strip.

Use only a PSC power adapter. Using another adapter can
damage the portable.

Note:

The portable is set at the factory with the following parameter settings
for serial communications. For explanations of these parameters, refer to
Serial Parameters, beginning on page 68. To change the parameter
settings, use the bar codes in Appendix G on page 128.

Parameter Default Setting
Baud rate 9600
Data bits 8

Parity None
Stop bits 1
Enable Xon/Xoff Off
Linefeed None
Protocol ACK/NAK
Timeout 1 second

To upload data to the computer, complete the following steps:

1. Prepare the computer to receive data by using one of the software
programs described in Transferring Data With PSC Utilities 0N

page 71.
Figure 3-70: Inventory Management Menu
I NV MGMT o
F2=COLLECT
F3=FI LE OPTI ONS
FS5=EXIT
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2. From the program menu on the PT2000 or TopGun (such as the
one from INVPRO shown in Figure 3-70), select <F3> to display
the File Options menu.

Figure 3-71: The File Options Menu
*FI LE OPTI ONS*

F2=SEND FI LE
F3=ERASE FI LE
FA=EX| To

3. Select <F2> to display the Send File menu.
Figure 3-72: Send File Menu

*SEND FI LE*
F2=SERI AL
F3=W\EDGE
FA=EXI Ta

4, Select <F2> to upload the data through the serial connection.

Keyboard Wedge Configuration

To upload data from the portable installed as a keyboard wedge,
complete the following steps:

1. Connect the portable to the PC as described on Installing the
Keyboard Wedge 0N page 21.

Figure 3-73: Asset Management Menu

ASSET MGMIe
F2=COLLECT

F3=FI LE OPTI ONS
FS5=EXIT

2. Open the PC application and place the cursor at the location
where data is to be entered.
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3. From the program menu on the PT2000 or TopGun (such as the
one from ASSETPRO shown above), select <F3> to display the
File Options menul.

Figure 3-74:; File Options Menu

*FI LE OPTI ONS*
F2=SEND FI LE
F3=ERASE FI LE
F4=EXI T=

4. Select <F2> to display the Send File menu.
Figure 3-75: Send File Menu

*SEND FI LE*
F2=SERI AL
F3=V\EDGE
FA=EXI Ta

5. Select <F3> to upload the data through the keyboard wedge
connection.

Removing Collected Data from Memory

After uploading a file from the PT2000 or TopGun to the PC, erase the
file from the portable’s memory. To do so, complete the following steps:

Figure 3-76: Item Tracking Menu
| TEM TRACKI NG=

F2=COLLECT
F3=FI LE OPTI ONS
FS5=EXIT
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1 From the program menu on the PT2000 or TopGun (such as the
one from TRACKPRO above), select <F3> to display the File
Options menu.

Figure 3-77: File Options Menu
*FI LE OPTI ONS*

F2=SEND FI LE
F3=ERASE FI LE
FA=EX| T

2. Select <F3>to display the Erase File menu.

Figure 3-78: Erase File Option
*ERASE FI LE*

F3=ERASE
F4=EX| T

3. Press the <F3> key to erase the file.

Turning Off the Portable

Turn the PT2000 or TopGun off by pressing the green <1/0> button

displayed at left. This will turn off the screen display, but it will not clear
any information in the portable’s random-access memory (RAM).

The portable is programmed to shut itself off automatically if it is not
used for ten minutes. Change the auto-off time by scanning the
appropriate bar code on page 140.
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Resetting the Portable

To reset the PT2000 or TopGun, remove the battery pack, alkaline
batteries, or external power supply. Then press and hold down the
<Alpha> and <ENTER> keys while reinserting the batteries or

reconnecting the power supply. The portable will prompt to enter the
current date and time.

Caution: Resetting the PT2000 or TopGun is similar to pressing
<Ctrl>+<Alt>+<Delete> on a PC. All data stored in the
portable's memory will be cleared.

Or, reset the PT2000 by scanning the following bar code:

* *

+ .
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Care and Cleaning

With normal use, the PT2000 or TopGun should require no
maintenance. If it gets dirty, wipe it with a damp cloth.

& Caution: Do not immerse the portable in liquid.
& Caution: Do not use any abrasive cleaners on the display screen.
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Programm
PT2000 and

TopGun and the PT2000 are configured with certain default paramete
are shipped from the factory. These settings will work for many applic:
settings by scanning the bar codes provided in this chapter and in Appe
Bar Codes, 0N page 127 or by creating bar codes for specific settings. C
programs to the portable from DOS or Windows.
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General Programming Paramete
Setting the Hour Format, Ti
Serial Parameters...........c...ccc......
Xmodem Protocol ................
Code 39 and ASCII Equivale
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Overview
PT2000 and TopGun recognize the following commands at all times:
‘“‘H“ ‘H H ‘“‘ Sets the portable to alpha mode
* /[ 4+ *
‘“‘H“ ‘Hll‘ ‘“‘ Sets the portable to normal mode
* [/ - %
‘“H H“‘ “ll‘ ‘“‘ Has the same effect as the <Clear> key
‘“H H“H H ‘“‘ Has the same effect as the <BKSP> (backspace) key
‘“‘H“ ‘l |H ‘“‘ Prepares the portable to accept a program
* [/ .
‘“‘l Hl“ “ll‘ ‘“‘ Sounds a low beep on the portable
‘“‘l Hl“‘ H ‘“‘ Sounds a high beep on the portable
‘“‘H ‘l |H ‘“‘ Clears all memory and resets the portable
' Retrieves data if the application program stops execution
and gives the PROGRAM FAILED message. Connect the
portable to the PC and start the communications program,
* $ $ * then scan this bar code. The data will transmit, one file at a
time.
Enter these commands with bar codes or through the PC’s serial port.
With PSC Program Generator (PPG), it is possible to embed these
codes in a PPG program. For information about using PPG to program
the portable, refer to the PSC Program Generator User Manual.
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Using Programming Utilities

7

PERCPROG

7

The PSC portable comes with a collection of applications and utilities
on a disk. This collection is called the Portable Applications Library, or
PAL. Two of the utilities, PDPROG and PERCPROG, enable
programming of the portable from DOS or Windows.

Note: For complete information about PAL, including installation
instructions, refer to the Falcon Portable Applications
Library (PAL) User’s Guide.

Both programming utilities check the version number of the portable’s
operating system. If it is different from the PAL version, it installs the
operating system along with the application.

PERCPROG is the utility used to program a PSC portable through
Windows.

To customize the installation of an application, complete the following
steps:

1 Connect the portable to the PC (refer to page 18 for information
on getting started.).

2. Double-click on the Portable Programmer icon in the PSC PAL
program group. The PSC Portable Programmer window will

open (refer to Figure 4-1).

Note:  The figures in this chapter show the utilities in Windows 95.
When using a different version of Windows, the utility
windows may look slightly different.

User’s Guide
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Figure 4-1: The PSC Portable Programmer (PERCPROG) Main Window

RIS
Ele  Gptiors e

3. From the menu, select Options > Settings. The Communications
Settings window will open (refer to Figure 4-2).

Figure 4-2: The Communications Settings window

COM Poat
" Comes 1
¥ [Comm 2
Ll o
™ IC o 4

I

4.  Select the desired serial port. Then select OK.

Note:  After changing the serial port setting, PERCPROG will keep

! the new setting until it is changed again. Use the icons in the

i' PSC PAL program group (Windows 3.1) or the Start Menu
(Windows 9x) to install an application.

5. From the PSC Portable Programmer menu, select File > Open.

The Program File window will open (refer to Figure 4-3).
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Figure 4-3: The Program File window
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6. Select the application to be installed in the portable, and click OK.

e The message Programming the portable will appear in the
programmer window. Additional messages and the percentage
of completion will be displayed as the programming
progresses.

e When programming is completed, the message Portable
successfully programmed will appear in the window, and the
name of the program file will be displayed in the window’s
title bar.

7. Select File > Exit to close the PSC Portable Programmer window.
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PDPROG

PDPROG is the utility used to program a PSC portable through DOS.

Using PDPROG involves entering commands on the DOS command
line. The command line syntax is as follows:

pdprog filename[.hex] [-]/]][port]
where

fi | enanme = the name of the file for the application to install in
the portable (The file has a .hex extension. Do not include the
extension in the command line.)

port =1} 2} 3} 4 to specify the serial port (default=COM?2)

The port setting is optional and can be entered either before or after the
file name. If used, precede it with a hyphen (-) or a slash (/).

For example, use the command pdpr og descri pt -1 to transfer the
description program to a portable over the COML1 serial port.
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Using Predefined Defaults

TopGun and the PT2000 have the following three sets of parameter
defaults:

Predefined Default O (DO) : turns every on/off parameter off and sets
all minimum and maximum lengths to zero.

Predefined Default 1 (D1): turns every on/off parameter on, sets all
minimum lengths as low as possible, and sets all maximum lengths as
high as possible.

Predefined Default 2 (D2) : is the default set that was installed in the
portable at the factory. This default set will work for most applications.

Note:  To restore the default settings for serial communications,
P scan Serial Communications Parameter (default) bar code
I 0N page 81.
Reset the portable to a predefined default set by scanning one of the
following bar codes:

oo {ININNINIARAMI
* + - DWEE =
or (NN
* + - D1 EE =
o2 {INNIAAMI
* + - D2 EE =*
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Using Bar Codes

To program the PT2000 and TopGun, scan Code 39 bar codes that
contain the desired parameters and settings. Appendix G On page 127
provides several programming bar codes. Custom bar codes can be made
using any bar code printing software that supports Code 39.

Guidelines for Creating Programming Bar Codes

Keep the following in mind when creating bar codes for programming
the portable:

e Create custom programming bar codes using the standard
Code 39 character set, not the extended (full ASCII) Code 39
character set. (However, bar codes must be read using extended
Code 39.)

e The first and last character of each bar code must be an asterisk
(*), the start and stop character for Code 39.

e The first asterisk of the programming bar code must be followed
immediately by the characters $+$- .

e The programming bar code must end with EE and an asterisk.
The portable will treat multiple bar codes of programming
information as one entry as long as * $+$- appears at the
beginning of the first bar code and EE* does not appear until the
end of the last bar code.

Scanning the following sample bar code will enable Code 39 scanning
and set the maximum length for Code 39 to 35 characters:

e [|[[NNVNALD
$ $ - 98 1823 5FEFE =

set max length to
7 Note: The human readable portion of the barcode symbol, as

+

35 characters *
shown here and elsewhere in this manual is optional and
not required for scanning purposes.
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Like all Code 39 bar codes, this sample starts and ends with an asterisk
(*). $+$- starts programming mode. 00 is the ID number for the
parameter that enables Code 39, and 1 turns it on. 02 specifies the
Code 39 maximum-length parameter, and 35 sets it to 35 characters per
label. EE saves the new settings and exits programming mode.

Using Multiple Bar Codes

Create multiple bar codes to program the portable. After making the
settings in the first bar code (which must begin with * $+$- ), the
portable waits for additional programming bar code entry if the first bar
code does not include EE* . Scanning the following two bar codes
provides the same result as scanning the single one on page 64:

$ - 8 8 1

$ +
* B 3 5 E E «

Commands cannot be split between two or more bar codes. It is not
possible to have a parameter ID number at the end of one bar code and
its setting or string at the beginning of the next.

s

*

2
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General Programming Parameters

Table 4-1 describes some of the general parameters for programming the
PT2000 or TopGun. For descriptions of serial parameters, refer to
Table 4-2. For a complete list of parameters and defaults, refer to

Appendix A.

Table 4-1: Selected Programming Parameters

ID # Parameter Description
05 Code 39 full | Supports the Code 39 extended ASCII character
ASCII set (refer to Appendix B on page 93). For example,
a character string encoded in Code 39 as +A is
transmitted as a lowercase a. This allows every key
of the keyboard to be encoded in a Code 39 bar
code.
06 Code 39 Treats multiple bar codes as a single bar code,
accumulate | provided that all bar codes except the last begin
with a space. The last code must not begin with a
space. Up to 128 characters (not including
preamble, postamble, and symbology identifiers)
can be accumulated before transmission.
0B 120f5 Enables use of checksums in Interleaved 2 of 5 bar
enable codes. This parameter should be set to On to read
checksum Interleaved 2 of 5 bar codes.
33,36 | UPC Converts UPC-A bar codes to EAN-13 (ID #33),
conversion and converts UPC-E bar codes to UPC-A (ID #36).
3B-3E | UPC/EAN/ Reads two-digit (ID #3C) and five-digit (ID #3D)
JAN extensions if the portable is programmed to allow
extensions them (ID #3B). Doesn’t read UPC, EAN, or JAN bar
codes if the portable is programmed to require
extensions (ID #3E) and no extensions are present.
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Setting the Hour Format, Time, and Date

Time: Turn parameter ID D8 on to set the portable’s real-time clock
display to 24-hour (military-style) format. When this parameter is set to
Off, the time is displayed in 12-hour format. The default time display is
24-hour format. Use the 12- and 24-hour bar codes to change the
format. To set the time on the portable’s clock, scan the Time bar code.

Date: Turn parameter ID D9 on to set the portable’s date display to
international format (day/month/year) or off to set it to U.S. format
(month/day/year). The default format is U.S. Format. To set the date in
the portable, scan the Date bar code. Use the International Format bar
codes to change the format.

* $ + $ - D 8 " EE =

* $ +$ - D81 EE =

* % - *

* % . %

* $ + $ -D 9 " EE =
Format

* $ + 8% - D9 1 EE =

Use the portable’s keyboard to enter the hour, time and date in the
current format.

Note:  When finished setting the date and time formats, press any
function key to return to the program.
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Serial Parameters

Use bar codes to set parameters for using the PT2000 or TopGun as a
serial device. Table 4-2 describes the serial parameters; bar codes for
setting them begin on _Serial Parameters on page 143. (For a complete
listing of parameters and defaults, refer to Appendix A.)

This section also includes a table of Code 39 and ASCII equivalents for
serial characters (refer to Table 4-3 on page 70). Use the Code 39
equivalents when creating bar codes for programming.

Table 4-2: Serial Parameters

ID # Parameter Description

C1 Baud rate Determines the communication speed. The
setting for the portable must match the setting
that the host computer uses.

Cc2 Data bits Specifies the number of data bits in each
character.
C3 Parity Specifies the parity of the data characters.
C4 Stop bits Selects the minimum space between data
characters.
C5 Xon/Xoff Used for software data-flow control. With this
handshaking option enabled, the portable transmits an Xoff

character when its serial input buffer has
fewer than ten characters of free space. Once
all the data in the serial buffer is processed,
the portable transmits an Xon character.

Xmodem Protocol

The PT2000 and TopGun support the Xmodem (checksum) file-
transfer protocol for serial communication, which is available in many
commercially marketed products.

68 PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



Serial Parameters

Xmodem is a simple send-and-wait-for-response protocol using a fixed-
length data field. The data field is embedded in an Xmodem packet,
which also contains a packet number and a single-byte arithmetic
checksum. The protocol link is established by the receiver transmitting a
NAK character until the sender responds. The sender responds by
transmitting an Xmodem packet. The sender then waits for either an
ACK signal, in which case it transmits the next packet, or a NAK signal,
in which case it retransmits the packet. Once all packets are transmitted,
the sender transmits an EOT signal, indicating the end of transmission.

Scan the following bar code to set a portable to use the Xmodem

protocol:
$ - CA N2 EE »

||
protocol i

+
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Code 39 and ASCII Equivalents for Serial Characters

Table 4-3 provides Code 39 and ASCII equivalents for serial characters.
For Code 39, ASCII, and mnemonic equivalents of keyboard keys, refer

1o Appendix B.
Table 4-3: Code 39 and ASCII Equivalents for Serial Characters

NUL %U 80 DLE $P 10
SOH $A 01 DC1 $Q 11
STX $B 02 DC2 $R 12
ETX $C 03 DC3 $S 13
EOT $D 04 DC4 $T 14
ENQ $E 05 NAK $U 15
ACK $F 06 SYN $V 16
BEL $G 07 ETB $wW 17
BS $H 08 CAN $X 18
HT $l 09 EM $Y 19
LF $J 0A SUB $Z 1A
VT $K 0B ESC %A 1B
FF $L oC FS %B 1C
CR $M 0D GS %C 1D
SO $N OE RS %D 1E
Sl $0 OF us %E 1F
Terminate string: //
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Transferring Data With PSC Utilities

Overview

After scanning a series of bar codes or inputting other data into the
PT2000 or TopGun, use a data-transfer utility to upload the
information to the host computer.

Note: To launch Windows applications, select menu options, use
dialog boxes, or refer to Microsoft Windows documentation.

Both the PT2000 and TopGun come with PSC’s Portable Applications
Library (PAL) on a disk. PAL includes two programs to transfer data
between the portable and a PC:

PTFER Windows application. (Refer to page 73.)

PDTFER DOS program that runs by issuing commands on the DOS command
line. (Refer to page 80.)

Note: PSC also provides two utilities MACTFER and UPDTFER

for transferring data to and from Macintosh or UNIX

I workstations. These utilities are free from PSC for your

J convenience, however their use is at your own risk, and not
supported by PSC Technical support. Go to the PSC website
at www.pscnet.com > Support > Software Updates > PT2000/
TopGun to download the most current transfer program.
Refer to Technical Support on page viii for more information.

MACTFER Macintosh program used to communicate via 8-pin DIN ADB (not
USB) with a Macintosh. (Refer to page 81.)

UPDTFER UNIX program used to communicate with a UNIX workstation. (Refer
to page 83.)

After collecting data with the portable, use one of these programs to
transfer the data to an ASCII file on the PC.
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Using Portable File Transfer Program (PTFER)

Installing & Setting up PTFER

To prepare for a data transfer between the PC and the PT2000 or
TopGun, complete the following steps:

1. If the utility software is not already installed on the PC, install it
following the instructions included with the diskette packaged
with the portable.

2. In Windows, click on the Portable File Transfer (PTFER) icon in
the PSC program group to get a blank PTFER window (refer to
Figure 5-1).

When using a different version of Windows, the utility

7 Note: The figures in this chapter show the utilities in Windows 95.
.I_ | #] windows may look slightly different.

Figure 5-1: The PSC Portable File Transfer window

o

Bl Cptions  Hep
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3. By default, PTFER uses the following communications settings:

Port cowe
Baud rate 9600
Stop bits 1

Data bits 8

Parity None
Protocol ACK/ NAK

These are also the default settings for the PT2000 and TopGun.
Scan the following bar code to set the portable’s serial
communications parameters to these defaults:
*$+$-C8EE™

Serial Communication H
parameters (defaults)

To switch to a different port or make other changes to the
defaults, refer to “Changing Settings,” ONn page 76.

4. Select Options >Connect (or click on the Connect button in
the Communications Settings dialog box) to connect with the
selected port.

5. The message Communications port opened appears in the
window. It is now possible to transfer files between the PC and
the portable.

Uploading a File
To upload a file from the PT2000 or TopGun to the PC:

1. Select File > Receive and use the File to Receive dialog box
(refer to Figure 5-2) to specify the name and location of the file to
store the data in.
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Figure 5-2: The File to Receive dialog box
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2. PTFER displays a message saying that it is expecting the file (refer

to Figure 5-3).

3. Make the appropriate selections on the portable to upload the
data into the specified file on the PC (refer to page 49).

Figure 5-3: The PTFER window during an upload

- Reereiving [EADETHE_]

B Qptons  Heo

— Communications pon spened, —

= W'aiting for file "FEALME, 13X, -

=10l =

j | J’ Note: If no success message appears, select a different port.

4. When the file has been successfully transferred, a message appears
in the PTFER window.
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Downloading a File
To send a file from the PC to the PT2000 or TopGun:

1. Prepare the portable to receive a file.

Note: Refer to the information about the DESCRIPT application
on Page 35.

2.  Then select File > Send from the PTFER menu.

3. Specify the name and location of the file in the File to Transmit
dialog box. (Except for the title bar, the File to Transmit dialog
box is identical to the File to Receive dialog box, shown in
Figure 5-4.)

4.  When the file has been successfully transferred, a message appears
in the PTFER window.

Changing Settings
By default, PTFER uses the PC’s COM2 port for communicating with
the portable.

If the COM2 port is already in use by a modem, mouse, or other device,
specify a different port or alter the communications settings for the port.

defaults. To restore factory defaults, scan the bar codes in

7 Note:  When not sure what settings to use, leave them at the
I Predefined Defaults on page 128

To use a different port or to alter port settings:

1. Select Options > Settings from the PTFER menu to receive the
Communications Settings dialog box (Figure 5-4).
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Figure 5-4: The Communications Settings dialog box

Por- Haud rate E.‘-unru:tll
CiComl] | 300

@com | como | [ 0k |

CCom3 | 1200
©Comd | | 2400 _Cancel |

™ 480D Parity
ritop @ 9600 = None
= 1 Bit ~ 19200 I Ddd
i~ 2 Bits " Even

Settings option is dimmed on the menu and cannot be
selected. Select Options > Connect again to disconnect the

7 Note: When a connection has been made to the serial port, the
iI
""" application, and then select Options > Settings again.

2. To use a different COM port, select it in the Port options group.

3. Use this dialog box to switch baud rate, the number of stop bits,
and the type of parity. (Use the settings which match the settings
used in the PT2000 or TopGun.)

4.  When finished, click on the Connect button to connect to the
port, or select OK and then use the Connect command in the
menu to make the connection.
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Setting Command Line Options

I7 Note:

In Windows 3.x, the command is in the Command Line
input box in the application’s Program Item Properties
window in the Program Manager.

In Windows 95, create a shortcut to the application. (The
Desktop is a good place to put the shortcut.) Find the
command in the Target input box on the Properties tab of the
shortcut’s Properties window.

Change settings for the Portable File Transfer program before starting
the program by entering options for the command that starts it. Type
the options using the following syntax:

ptfer filename[-|/][Pn][Bn][Dn][action]

where

fil ename = the name of the file to transfer (include the extension)

Pn =

Bn
Dn =

action=

the number of the COM port to be used (1, 2, 3, or 4; the
default setting is P2)

the baud rate to use (the default setting is B9600)

the timeout period, in seconds (the default is 30 seconds on
receive and 1 second on transmit)

Ato receive data and append it to the existing file

C to connect automatically when transmitting or receiving

E to echo the display to the screen

H to display on screen help

Mto maximize the PTFER window

N to minimize the PTFER window

On n n to set the size and position of the PTFER window

Rto receive data from the portable and replace the existing
file contents

S to display the line count in the title bar

T to transfer data to the portable (the default)

X to exit automatically after data is transmitted or received
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The port, baud rate, timeout, and action parameters are optional. If
using one or more parameters, precede them with a hyphen (- ) or a slash
(/). Enter parameters either before or after the file name.

For example: the command pt f er I'i nk. t xt / P1 would send the
file named I i nk. t xt over COML1 to the portable (the default action,
T, is assumed). The command pt f er - 3r dat a. t xt would upload
data from the portable over COM3 into a file named dat a. t xt .

The port, baud rate, and position and size settings are saved to and
restored from the initialization file.
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Using PDTFER

Instead of using the PTFER application in Windows, transfer files to and
from the PT2000 or TopGun using commands on the DOS command
line.

The command line syntax for transferring files with PTFER is as follows:

pdtfer filename[-|/][port][Bn][Dn][action]
where

fi | ename = the name of the file to transfer (include the extension)

por t =the number of the COM port to use (1, 2, 3, or 4; the default
setting is 2)
Bn = the baud rate to use (the default setting is B9600)

Dn = the timeout period, in seconds (the default is 30 seconds on
receive and 1 second on transmit)

action = Ato receive data and append it to the existing file
E to echo the display to the screen
H to display on screen help
Rto receive data from the portable and replace the existing
file contents
T to transfer data to the portable (the default)

The port, baud rate, timeout, and action parameters are optional. When
using one or more parameters, precede them with a hyphen (-) or a
slash (/). Enter parameters either before or after the file name.

For example, the command pdt f er |i nk. t xt / 1 sends the file
named | i nk. t xt over COM1 to the portable (the default action, T, is
assumed). The command pdt f er -3r dat a. t xt would upload data
from the portable over COM3 into a file named dat a. t xt .

7 Note: Files must be transferred to or from the current DOS

directory.
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Using MACTFER

Use the MACTFER program to transfer data between a PT2000 or
TopGun and a Macintosh. Only one cable is required to connect the
portable to a Macintosh. (Contact a PSC dealer to order.)

To transfer data using the MACTFER program, complete the following

steps:

1

I7 Note:

Copy the mact f er . exe file from the supplied floppy disk to the
Macintosh hard drive.

Scan the following bar code to make sure the portable’s serial
communications parameters are set to the defaults:

-C8EE*™
Connect the Macintosh cable to the PT Dock.

Serial Communication
parameters (defaults)

Connect the other end of the serial cable to the cable input jack
on the bottom of the portable.

Plug the mini-DIN end of the Macintosh cable into the
Macintosh modem port. The modem port is marked: &,

Start the MACTFER program on the Macintosh. An untitled
window appears for displaying received or transferred data.

To upload a file from the portable to the Macintosh, select File >
Receive and use the Receive File dialog box to specify the name
and location of the file to store the data in. Then select options on
the portable to upload the data into the specified Macintosh file.

Copy received data to other applications using the Edit >
Copy command.
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8. To send a file to the portable, select File > Send and specify the
name and location of the file in the Send File dialog box. To
accept the transferred file, the portable must be programmed to
accept serial input and store it in a file or register. Depending on
the program, it may be necessary to select some options on the
portable first.
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Using UPDTFER

7

Use the UPDTFER program to transfer data between a PT2000 or
TopGun and a UNIX workstation. The UPDTFER program transmits
and receives data to or from the portable using PSC’s ACK/NAK
protocol.

Note: Refer to the PSC website at www.pscnet.com > Support >
Software Updates > PT2000/TopGun to download the UNIX
transer file (UNIXUPLD.zip unzips to UPDTFER.exe).

To install the program, use the UNIX t ar command to copy the
UPDTFER file from the supplied floppy disk or website download to the
UNIX workstation’s hard drive.

Use the following command syntax to transfer files with updtfer:
updtfer device filename -options

where
devi ce = the serial port device name, such as /dev/ttyla
fi | ename = the name of the file to transfer
opt i ons =one or more transfer options, preceded by a hyphen
-)
Use any of the following options:

t  transmits data in the given file to the portable. The portable
should be properly connected to the specified serial port
and ready to receive data.

r  receives data from the portable and stores it in the given
file. When receiving data from the portable, start UPDTFER
before invoking the transfer on the portable.

a appends the given file with data received from the portable.

d displays debugging information on the screen during
transfer.
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s performs the transfer “silently” (without displaying received
data on the screen).

h  displays help on program usage and options.

For example: updt f er / dev/tty2areadin. dat - r would receive
data from a portable connected to a serial port named /dev/tty2a and
place data in a file named r eadi n. dat .

The UPDTFER program has the following settings. The portable’s
communications settings must match.
® Baud rate: 9600
Stop bits: 1
Data bits: 8
Parity: None
Flow control: ACK/ NAK; no XON/ XOFF

The UPDTFER program returns an exit status of O if the transfer is
successful. If the transfer is unsuccessful, it returns a nonzero status, such
as 1.
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Programming Parameters

Overview

I P Note: For information about programming, refer to Chapter 4.

This appendix provides information about all programmable settings for
the PT2000 and TopGun.

e Table A-1: lists programming ID numbers for predefined defaults
(refer to page 87).

e Table A-2: lists save-and-exit settings (refer to page 87).

e Table A-3: provides the following information (refer to page 88):

refer to page 66. For explanations of serial parameters, refer

7 Note:  For explanations of some general programming parameters,
I to page 68.

Code Parameter : is the “human” name for programming options.

ID # : is the “portable” name for programming options. For example, to
set a Code 39 minimum label length, enter 01 when programming the
portable. Programming ID numbers given in this appendix can be used
with all programming methods.

Type : tells what kind of setting to use for each code parameter:
On/Off : is a toggle. 1 turns the parameter on, and O turns it off.

Value : requires a two-character entry (e.g., 02 for two beeps after each
good read, or 05 for a length of five).

String : uses one or more ASCII characters, followed by / / to indicate
the end of the string.

Immediate : takes effect as soon as the ID number is entered.

Acceptable Input : gives the settings or range of settings that you can
use for each code parameter.

86 PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



Overview

Predefined Defaults : tells how the parameter is set when you select

predefined default DO, D1, or D2 (refer to page 87).

e Table A-4:, beginning on page 91, lists parameter settings for serial

communications.

Table A-1: Predefined Defaults

Predefined default set 0 DO Immediate

Predefined default set 1 D1 Immediate

Predefined default set 2 D2 Immediate

Predefined serial defaults Cc8 Immediate
Table A-2: Save-and-Exit Settings

Save and exit EE Immediate

Exit only, no save EF Immediate
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Table A-3: General Programming Parameters

Code 39 Enter 1 for On and 0 for Off.
Enable 00 On/Off On or Off Off On On
Minimum length 01 Value 00-60 00 00 00
Maximum length 02 Value 00-60 00 60 20
Enable checksum 03 Oon/Off On or Off off Off Off
Send checksum 04 On/Off On or Off Off Off Off
Full ASCIl mode 05 On/Off On or Off Off On On
Accumulate mode 06 On/Off On or Off Off On Off
Enable AIAG alternate 07 On/Off On or Off Off Off Off
check digit

Interleaved 2 of 5 Enter 1 for On and 0 for Off.
Enable 08 On/Off On or Off Off On On
Minimum length 09 Value 02-60 02 02 06
Maximum length 0A Value 02-60 02 60 10
Enable checksum 0B On/Off On or Off Off Off Off
Send checksum oc Oon/Off On or Off off Off Off
Use lengths 6 and 14 only 0D On/Off On or Off Off Off Off
(case code)

Codabar Enter 1 for On and 0 for Off.
Enable 20 On/Off On or Off Off On On
Minimum length 21 Value 00-60 00 02 04
Maximum length 22 Value 00-60 00 60 20
Send start/stop 23 On/Off On or Off Off Off Off
Convert Codabar to CLSI 24 On/Off On or Off Off Off Off
Code 93 Enter 1 for On and 0 for Off.
Enable 2C On/Off On or Off Off On On
Minimum length 2D Value 00-50 00 01 02
Maximum length 2E Value 01-50 00 50 20
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Overview

Universal Product Code-A (UPC-A)

Enter 1 for On and 0 for Off.

Enable 30 On/Off On or Off Off On On

Send system digit 31 On/Off On or Off Off On Oon

Send check digit 32 On/Off On or Off Off On Off
Convert UPC-A to EAN-13 33 On/Off On or Off Off On Off
Universal Product Code-E (UPC-E) Enter 1 for On and 0 for Off.
Use system digit 0 34 On/Off On or Off Off On On

Use system digit 1 35 On/Off On or Off Off On Oon

Convert UPC-E to UPC-A 36 On/Off On or Off Off On off
Send system digit 37 On/Off On or Off Off On Off
Send check digit 38 On/Off On or Off Off On Off
European Article Numbering (EAN)/ Enter 1 for On and 0 for Off.
Japan Article Numbering (JAN)

Enable EAN-8/JAN-8 39 On/Off On or Off Off On On

Enable EAN-13/JAN-13 3A Oon/Off On or Off Off On On

Convert EAN-13 to ISBN 3B On/Off On or Off Off Off Off

Send check digit 3F On/Off On or Off Off Off On

UPC, EAN, JAN Extensions Enter 1 for On and 0 for Off.
Allow 2-digit extensions 3C On/Off On or Off Off On On

Allow 5-digit extensions 3D On/Off On or Off Off On On

Require extensions 3E On/Off On or Off Off Off Off

Code 128 Enter 1 for On and 0 for Off.
Enable 40 On/Off On or Off Off On On

Minimum length 41 Value 00-60 00 02 02

Maximum length 42 Value 00-60 00 60 20

Enable UCC128 43 On/Off On or Off Off Off Off
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Programming Parameters

Other Controls Enter 1 for On and 0 for Off.
Enable manual reset BO On/Off On or Off On On On
Auto-Off B2 Value 00-99 00 60 10
(minutes)
Intercharacter delay (keyboard B3 Value 00-99 00 06 00
wedge only) (milliseconds)
Add symbology identifiers” B5 on/Off On or Off Off on off
Good-read tone B8 Value 00 (low) — 07 (high) 05 05 05
Good-read number of beeps B9 Value 01-04 01 01 01
Good-read tone duration BA Value 00 = 0.14 sec. 01 01 01
01 = 0.07 sec.
02 = 0.45 sec.
03 =0.22 sec.
Beeper volume BC Value 00 = Off 07 07 07

01 (low) — 07 (high)
08 = One level higher
09 = One level lower

Error tone BD Value 00 (low) — 07 (high) 03 03 03
Time format D8 On/Off On = 24-hour on on on
Off = 12-hour
Date format D9 On/Off On = International Off Off Off
Off = U.S.
Keyboard click DD On/Off On or Off On Oon Oon
Laser delay DE Value 00-99 01 01 01
(10-millisecond units)
* A =UPC-A E =UPC-E K = Code 128
B = Interleaved 2 of 5 G =EAN-8 L =Code 93
C =Code 39 | = Codabar M = EAN-13
90 PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



Overview

Table A-4: Serial Programming Parameters

Enter 1 for On and 0 for Off.

Host select co Value 11 = ATs, PS/2s, and None
compatibles
15 = IBM terminals

Baud rate Cc1 Value 00 =300 05
01 =600
02 = 1200
03 = 2400
04 = 4800
05 = 9600
06 = 19,200
07 = 38,400
08 = 76,800
Data bits c2 Value 07 =7 bits 08
08 = 8 hits
Parity C3 Value 00 = None 00
03 =0dd
04 = Even
Stop bits Cc4 Value 01 =1 bit 01
02 = 2 hits
Enable Xon/Xoff C5 On/Off On or Off Off

Linefeed (LF) c6 Value 00 = None 00
(Valid for CA = 00 only) 01 = Strip LF
02 = Add LF

Predefined serial defaults c8

End-of-file character C9 Value Any single ASCII 1A
character

Protocol CA Value 00 = EOR only 01
01 = CR with checksum
and ACK/NAK response
02 = Xmodem
End-of-record (EOR) character CcC Value Any single (CR)
ASCII character

Timeout CD Value 00-99 10
(100-millisecond units)
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Full Keyboard Support

Overview

7

Almost every key on the keyboard, including non-printing keys, can be
programmed into the PT2000 or TopGun. The tables in this appendix
list Code 39 equivalents for programming all keyboard keys.

Use the Code 39 values to create bar codes to include lowercase or non-
alphanumeric characters in a bar code. For example, to include an
exclamation mark (! ) in a bar code, encode it as / A (slash capital a).

Note: Full ASCII mode for Code 39 must be enabled in the
portable.

Some keys act immediately when read into the portable. For example,
the portable transmits the page-down command to the computer as
soon as it reads a bar code containing the characters %J$Z.

Other keys are not quite so simple. For example, the <Ctrl> key has to
be “turned on and off.” When typing <Ctrl>+<C>, for instance, hold
the <Ctrl> key down while pressing <C>, then release the <Ctrl> key.
Three signals are sent to the host device:

<Ctrl> key on (down)<C>  <Ctrl> key off (up)
To include the <Ctrl>+<C> keystroke combination in a bar code,
encode $SC3R. Think this way when encoding <Ctrl>, <Alt>, <Shift>,
and other keys requiring a key to be held down while another is pressed.

Including a function key in a bar code can present a problem if the
portable is programmed to follow every bar code transmission with an
autoterminator character. Eliminate the autoterminator in a bar code by
including the “zap” character, $Z, in any bar code not followed by the
autoterminator. For example, encode %AJ$A$Z to send function key
<F1> with no autoterminator.

Table B-1 on page 95 lists the Code 39 and ASCII equivalents for keys
that are common to many keyboards. Table B-2 on page 97 lists
equivalents for additional keys found on IBM PC and compatible
keyboards.

94

PT2000™ & TopGun™

Download from Www.Somanuals.com. All Manuals Search And Download.



Overview

Table B-1: Common Keyboard Keys

Key Code 39 C;C; : Key Code 39 C:Ii :

SP space 20 : 1z 3A
! /A 21 ; %F 3B
" /B 22 < %G 3C
# /IC 23 = %H 3D
$ /D 24 > %l 3E
% IE 25 ? %J 3F
& IF 26 A A 41
' G 27 B B 42
( H 28 C C 43
) /l 29 D D 44
* 1 2A E E 45
+ /K 2B F F 46
) /L 2C G G 47
- -or/M 2D H H 48
.or/N 2E | | 49

/ /0 2F J J 4A
0 Oor/P 30 K K 4B
1 lor/Q 31 L L 4C
2 2or/R 32 M M 4D
3 3or/S 33 N N 4E
4 4or/T 34 (0] O 4F
5 5or/U 35 P P 50
6 6or/V 36 Q Q 51
4 4or/T 34 R R 52
5 5or/U 35 S S 53
6 6 or/V 36 T T 54
7 7 or /W 37 U U 55
8 8 or /X 38 \% \% 56
9 9orlY 39 w w 57

table continues
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Full Keyboard Support

X X 58 o +0 6F
Y Y 59 p +P 70
pa z 5A q +Q 71
@ %V 40 r +R 72
[ %K 5B s +S 73
\ %L 5C t +T 74
] %M 5D u +U 75
n %N 5E Y +V 76
_ %0 5F w +W 77
a +A 61 u +U 75
b +B 62 v +V 76
c +C 63 w +W 77
d +D 64 X +X 78
e +E 65 y +Y 79
f +F 66 z +Z 7A
g +G 67 ‘ %W 60
h +H 68 { %P 61
[ +| 69 | %Q 7C
i +J 6A } %R 7D
k +K 6B ~ %S 7E
| +L 6C Del %T TF
m +M 6D Zap $Z 1A
n +N 6E
*Not an actual key; see information about the “zap” character on page 94\
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Overview

Table B-2: IBM (or Compatible) PC Keyboard Keys

F1 %USA 8001 | %U%A 801B

F2 %U$B 8002 a %U%B 801C

F3 %US$C 8003 h %U%C 801D

F4 %U$D 8004 A %U%D 801E
F5 %USE 8005 Caps Lock $C 03
F6 %US$F 8006 Num Lock $D 04
F7 %U$G 8007 Scroll Lock $E 05
F8 %U$H 8008 Backspace $H 08
F9 %USI 8009 Horizontal Tab $l 09
F10 %U$J 800A Vertical Tab $K 0B
F11 %U$K 800B Enter $M oD
F12 %US$L 800C Alt Off $N OE
Insert %U$U 8015 Alt On $0 OF
Home %U$V 8016 Ctrl Off $R 12
Page Up %USW 8017 Ctrl On $S 13
Delete %USX 8018 Shift Off $V 16
End %USY 8019 Shift On W 17
Page Down %U$SZ 801A Esc %A 1B

[ NumeroKeypad |

Enter %U%E 801F 3 %U3 8033

* %U/J 802A 4 %U4 8034

+ %U/K 802B 5 %U5 8035

- %U- 802D 6 %U6 8036

/ %U/O 802F 7 %U7 8037

0 %U0 8030 8 %U8 8038

1 %U1 8031 9 %U9 8039

2 %U2 8032
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The TopGun
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The TopGun Module

Attaching the TopGun Module to the PT2000

If the TopGun module and PT2000 were purchased separately,
complete the following steps to connect them:

1. Pull the hook on the elastic hand strap out of the holder near the
base of the PT2000 (refer to Figure C-1).

Figure C-1: The back of the PT 2000

Remove these screws after
releasing the hook

b Release the strap hook here

2. Remove the two screws that attach the other end of the hand strap
to the PT 2000 (refer to Figure C-1).
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Attaching the TopGun Module to the PT2000

I Note: Contact a PSC dealer to order a replacement hand strap
and screws. Request the PT2000 strap kit.

Figure C-2: Attaching the TopGun module

3. Place the TopGun module on the top of the PT2000 and gently
press it onto the 9-pin connector (refer to Figure C-2).
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The TopGun Module

4. Place the flat metal plate at the top end of the elastic hand strap
over the indentation on the back of the TopGun module and
insert the screws (refer to Figure C-3).

Figure C-3: Replacing the hand strap (magnified view)

Indentation on back

of TopGun module Flat metal plate

Hand strap

5. Tighten the screws until the metal plate is secure.

6. Replace the hand-strap hook into its holder.
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Changing TopGun to a Left-Handed Model

Changing TopGun to a Left-Handed Model

TopGun comes assembled for right-handed use. To use the unit with the
left hand, complete the following steps as shown in Figure C-4:

1. Remove the two screws from the top of the TopGun module.

Figure C-4: Switching the Direction of the TopGun Module

£ sept {3
Q Step 5 Q

Step 4

Step 2
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The TopGun Module

2. Gently lift the top to separate it from the rest of the module. (Be
careful not to break the ribbon cable inside the module.)

3. Turn the top around so that the laser is pointing in the opposite
direction.

Replace the top of the module.

5. Insert and tighten the two screws. (Do not over tighten them.)
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Laser Specifications and Labeling

Laser Specifications and Labeling

e Laser classification: CDRH Class 11

e Light source: 680-nm laser diode

e Minimum element width: 6.0 mils

e Depth of field: 2 to 24 inches (55-mil labels)

e Operating temperature: -4° to 109°F (-20° to 43°C)

Figure C-5: Product labeling for the TopGun module

kB

CLASS Il LASER PRODUCT
AVOID LONG TERM VIEWING
OF DIRECT LASER LIGHT
AVOID EXPOSURE-LASERLIGHT
IS EMITTED FROM THIS APERTURE

LASER LIGHT-DO NOT
i éé STARE INTO BEAM
680nm LASER
1.0 MILLIWATT MAX QUTPUT
CLASS Il LASER PRODUCT

P=RCON
NUMBER
[
INCORPORATED
TopGUN ot sen
5“3??161&3 COMPLIES WITH
21 CFR 1040
SERIAL PAT
NOMBER 4,387,297
4593186
4,758,717
5.130.520
4,460,120
; -
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The PT Dock

About the PT Dock

The PSC PT Dock is specially designed for use with the PT2000 or
TopGun. Use the dock for data transmission between the portable and a
PC. Remove the portable from the dock to use it for data collection.

The PT Dock comes with the following accessories:

e An adapter for the base of the PT2000 or TopGun, and two
screws

e Rubber pads and Velcro™ strips for the bottom of the dock

A Power adapter and cables for the PT Dock are available separately
from a PSC dealer.

Setting Up the Dock

Attaching the Dock Adapter to the Portable

Before using the PT Dock for the first time, connect the adapter to the
base of the PT2000 or TopGun. Complete the steps in Figure D-1:

& Caution: Be careful not to overtighten the screws.

1. Align the pins on the PT Dock adapter with the holes in the
connector on the base of the PT2000 or TopGun. Be sure the
orientation of the adapter matches the orientation of the base, as
shown in Figure D-2 on page 109.
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Setting Up the Dock

2. Gently press the PT Dock adapter into the base of the PT2000 or
TopGun.

Figure D-1: The PT2000, PT Dock, and adapter

& O
1 U1

\

3. Use the two provided screws to secure the adapter to the portable.

Figure D-2: Attaching the adapter

Base of PT2000 or TopGun with
keypad side up

Adapter, with longest edge up

o)
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The PT Dock

Attaching the PT Dock to a Computer

Set up the Dock as either a serial device or a keyboard wedge. The cable
part number will depend upon your computer type and desired
configuration (serial or keyboard wedge).

quick link, contact a PSC dealer, or contact PSC customer
service at (541) 683-5700 to determine the appropriate PSC
o cable to use with the PT Dock.

7 Note: Refer to PSC’s website at www.pscnet.com at the Service

Caution: Do not attempt to connect a PT Dock to a PC using an
off-the-shelf RS-232 cable. Use a PSC cable
manufactured specifically for the PT Dock.

Serial 1. Be sure the power to the workstation is turned off.

Configuration 2. One plug on the serial cable is labeled with the cable part number.

Attach that plug to the cable input jack on the back of the
PT Dock (refer to Figure D-3).

power adapter is used only to recharge the NiCd batteries in
the portable. However, without an adaptor, the LED
indicators on the PT Dock will not light up.

7 Note: A power adapter is not required to run the PT Dock. The

3. Attach the other end of the cable to an available serial port on the
PC.

4. If there is an optional power adapter, attach it to the power input
jack on the back of the PT Dock. (Refer to page 112 for more
information about the power adapter.)

5. Turn the workstation on.

Keyboard To configure the keyboard wedge, complete the following steps:
Wedge

. . 1. Turn off the power to the workstation.
Configuration

110 PT2000™ & TopGun™
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Setting Up the Dock

2. Plug the 25-pin connector of the cable into the cable input jack
on the back of the PT Dock (refer to Figure D-3).

Figure D-3: Back of the PT Dock

Power input jack Cable input jack

3. Attach the small male plug of the PSC cable to the keyboard jack
on the workstation (refer to Figure D-4 on page 112).

4. Attach the keyboard cable to the small female jack on the PSC
cable (refer to Figure D-4 on page 112).

5. Turn the workstation on. The green light-emitting diode (LED)
labeled POWER on the front panel of the PT Dock should light
up.
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The PT Dock

Figure D-4:

Sample PSC Keyboard wedge

To computer
To keyboard

To PT Dock
(S(UUUUUUUU\E)

| 00-00I-00
—

About the Power Adapter

7

To use the PT Dock with a serial cable, use a 9-volt power adapter to
recharge the NiCd batteries in the PT2000 or TopGun. Power adapters
are available from a PSC dealer. (When using the keyboard wedge
configuration, power is supplied by the workstation.)

Note: Use only a 9-volt power adapter supplied by PSC. Using
another adapter can damage the unit.

Attach the small, round plug of the power adapter to the power input
jack on the back of the PT Dock (refer to Figure D-3). Plug the other end
into a 110-volt outlet or power strip. The green light-emitting diode
(LED) labeled POWER on the front panel of the PT Dock should light
up.

112
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Using the PT Dock

Using the PT Dock

Set up the PT Dock as described in the preceding section. Place the
PT2000 or TopGun into the dock, with the keypad facing out. To use a
power adapter or the keyboard wedge configuration, the green LED
labeled READY on the front panel of the PT Dock should light up. (If
the READY light does not come on, make sure the POWER light is on
and the portable is fully inserted into the dock. If it still doesn’t work,
make sure the PT Dock adapter is securely attached to the portable and
that the contacts in the dock are clean.)

When the portable is in the Dock, the user may download programs or
data to it, or upload data from it, just as if it were connected directly to a
workstation. The user can also leave the unit in the dock while using an
attached bar code reader.

Recharging the Portable’s Batteries

I7 Note:  Use the keyboard wedge connection or the power adapter to

Maintenance

recharge the batteries.

When using a nickel-cadmium (NiCd) battery pack in the portable, use
the PT Dock to recharge it. Leave the battery pack in the portable while
it is in the dock. The battery pack and the backup battery will be
recharged while the READY light is on. (Refer to page page 116 to make
sure Switch 2 in the portable’s battery compartment is correctly
positioned.)

With normal use, the PT Dock should require no maintenance. To
clean the contacts in the Dock or on the adapter, wipe them with a
damp cloth after removing the power supply (adapter or keyboard
wedge cable) from the unit. Wait for the contacts to dry before using the
PT Dock again.
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The PT2000 and TopGun run on two types of batteries. The main bat
power for the PT2000 unit and for the TopGun module or another inp
lithium battery provides backup power to maintain the random-access
clock when the main batteries are removed.

The portable can use two different types of main batteries: individual ¢
rechargeable nickel-cadmium (NiCd) battery pack.

APPENDIX CONTENTS

Alkaline Batteries
NiCd Battery Pack............c........
Recharging the NiCd Battery
Storing the NiCd Battery Pac
Lithium Backup Battery............
Low Battery Indication..............
NiCd Battery Pack or Alkaling
Backup Battery ............cc.......
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Batteries

Alkaline Batteries

The PSC PT2000 or TopGun comes with three alkaline batteries
installed. To replace the alkaline batteries, complete the following steps:

1. Detach the elastic hand strap on the back of the portable by
pulling its hook out of its holder near the base (refer to Figure C-1

on page 100).

2. Press on the arrow symbol on the battery-compartment cover and
push the cover in the direction indicated by the arrow.

3. Pull the end of the plastic ribbon sticking out of the battery
compartment toward the batteries until they pop out.

4. Set the two switches inside of the battery compartment for the
type of batteries being used.

Figure E-1: Base of the battery compartment

Close-up shows
switch 1 in ALK

_\i,_ I position and
switch 2 in NI-Cd
position

e Refer to the diagram inside the battery compartment which
indicates the positions for alkaline (ALK) and nickel-
cadmium (Nicd) batteries (refer to Figure E-1).

e Make sure Switch 2 is in the ALK position. If necessary, use a
pen or a small screwdriver to slide the switch to that position.
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NiCd Battery Pack

Caution: Switch 2 must be in the ALK position to prevent the unit
from attempting to charge the alkaline batteries. This
could cause them to leak, damage the unit, and void the
product warranty.

e Switch 1 may be in either position.

5. Lay the plastic ribbon along the bottom of the battery
compartment with the end sticking out of the compartment.

6. Insert the batteries in the positions indicated by the diagram
inside the compartment.

7. Replace the battery-compartment cover by sliding it into place.
e Make sure the plastic ribbon is tucked underneath the cover.

8. Replace the hand-strap hook into its holder.

NiCd Battery Pack

The battery pack for the PT2000 and TopGun (PSC part #00-862-00)
contains three rechargeable AA NiCd batteries. To install the NiCd
battery pack, complete the following steps:

1. Detach the elastic hand strap on the back of the portable by
pulling its hook out of its holder near the base (refer to Figure C-1

on page 100).

2. Press on the arrow symbol on the battery-compartment cover and
push the cover in the direction indicated by the arrow.
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Batteries

3. Pull the end of the plastic ribbon sticking out of the battery
compartment toward the batteries until they pop out.

4. Set the two switches inside of the battery compartment for the
type of batteries being used.

e Refer to the diagram inside the battery compartment which
indicates the positions for alkaline (ALK) and nickel-
cadmium (NiCd) batteries (refer to Figure E-1).

e Make sure Switch 2 is in the NiCd position. If necessary, use a
pen or a small screwdriver to slide the switch to that position.

e Switch 1 may be in either position.

5. Lay the plastic ribbon along the bottom of the battery
compartment with the end hanging out of the compartment.

6. Find the positive (+) and negative (-) symbols on the battery pack’s
label (refer to Figure E-2). With the label facing up, tilt the
negative end of the pack into the upper end of the battery
compartment, and then gently press the positive end until it is
fully inserted into the battery compartment.

Figure E-2: Battery pack label

/ 1
Z
28
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> (f)
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Ho ()
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7. Replace the battery-compartment cover by sliding it into place.
e Make sure the plastic ribbon is tucked underneath the cover.
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NiCd Battery Pack

8. Replace the hand-strap hook into its holder.

Caution: Do not short-circuit a battery—damage to the battery
can result. Do not incinerate, crush, or puncture

batteries. The electrolyte contained in NiCd batteries is
composed of caustic materials that are harmful to the
eyes and skin. Dispose of batteries in compliance with all
applicable regulations.

Recharging the NiCd Battery Pack

If the portable will not turn on or if the message LOW BATTERY appears
on the display, the battery pack needs recharging. To recharge the NiCd
battery pack, use a cable and an external 9-volt power adapter (refer to
Figure D-1 on page 109). A full charge takes about eight hours.

To recharge the NiCd battery pack, complete the following steps:
1. If the portable is on, turn it off.

2. One of the connectors on the cable has the cable number on it.
Plug that connector into the cable input jack on the bottom of the
portable.

Caution: Use only a power adapter supplied by a PSC dealer.
Using another adapter can damage the unit.

3. Attach the small, round plug of the 9-volt power adapter to the
round power input jack on the cable connector labeled
COMPUTER. Plug the other end into an outlet or power strip.

Use the PT Dock to recharge the NiCd batteries. Leave the batteries in
the unit while it is in the Dock. The batteries recharge while the READY
light is on. (Make sure Switch 2 in the portable’s battery compartment is
in the NiCd position,; refer to Figure E-1.)
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Batteries

It is best to charge the battery pack at or slightly below room
temperature. Always charge the battery within the temperature range of
50°-85°F (10°-30°C).

Storing the NiCd Battery Pack

The battery pack can be stored indefinitely, regardless of its charge state.
Store it between -22° and 122°F (-30° to 50°C). Stored batteries lose
about ten percent of their charge per month when they are kept at room
temperature. Batteries stored at higher temperatures discharge at a faster
rate.

Lithium Backup Battery

The portable contains a lithium battery as a backup to save application
program codes, collected data and system information, including the
clock setting. Under most circumstances, a fully charged backup battery
will keep information for at least 10 days if the main batteries are
completely discharged or removed. This should provide sufficient time
to recharge the battery pack without risk of losing data.

The backup battery is recharged whenever a charged battery pack is
installed as well as when the power supply is connected.

If the lithium battery is allowed to discharge, any application program
code that is resident in the random-access memory will be lost,
Consequently, when a charged battery pack is installed and the unit is
turned ON, it is likely that the operating system will detect the
corrupted application code and will display a PROGRAM FAILED
message.
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Low Battery Indication

Low Battery Indication

NiCd Battery Pack or Alkaline Batteries

The portable indicates when the battery pack or alkaline batteries are
low by flashing LOW BATTERY on the display. About 20 minutes of
use remain before the main batteries reach their automatic low-power
shutdown point.

If the battery pack is not recharged before it reaches the low-power
shutdown point, it continues to discharge, and the portable turns off
automatically. Even then, the portable continues to save data, because of
the lithium backup battery. It is important, however, to recharge the
battery pack or replace the alkaline batteries at this time to avoid
running down the backup battery and losing data.

Backup Battery

When the lithium backup battery is low. or after inserting a battery pack
if the portable has been stored for a long time without charging, the
message in Figure E-3 appears on the display

Figure E-3: Please Wait Charging Backup Battery Message

PLEASE WAI T
CHARG NG
BACKUP BATTERY

o]
The backup battery begins recharging as soon as a charged battery pack
is inserted. The message should disappear after approximately 10
minutes, although it may take up to an hour to recharge a completely
discharged backup battery.

Caution: Do not remove the battery pack while the message is on
& the display, or data may be lost. Charge the battery pack

inside the portable while using the Dock.
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Batteries

If the message does not disappear or occurs other than at initial use after
prolonged storage, then the backup battery may no longer be accepting
a charge from the battery pack or adapter. Contact a PSC dealer.

Use the PT Dock to recharge the lithium backup battery in the portable.
The battery will be recharged while the READY light is on. (Make sure
the switch in the portable’s battery compartment is in the correct
position for the type of batteries being used.)
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Connector Configu

APPENDIX CONTENTS

Bar Code & Magnetic Stripe Rea
Interface Cable Connector.........
PT DOCK....cveeeeeeiiieeeeee e
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Connector Configurations

Bar Code & Magnetic Stripe Reader Connector

Figure F-1: Bar Code & Magnetic Stripe Reader Pinouts

Table F-1: Bar Code & Magnetic Stripe Reader Pinouts

Laser sync in

Bar code data in

Good-read out

Mag stripe information in

Laser trigger in

Laser-scan enable out

Ground

Ground

O 0| N[ Oof O | W[ N[

+5V
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Interface Cable Connector

Interface Cable Connector

Figure F-2: Interface Cable Connector Pinouts
Pin #8 Pin #1

Pin #15

Table F-2: Interface Cable Connector Pinouts

Pin # Description

1 Shield

2 Transmit data out

3 Receive data in

4 Hardware handshake out*

5 Hardware handshake in

6 Not used

7 Ground

8 Cable detect

9 +5V in

10 +9Vin

11 485+

12 485-

13 Wedge clock

14 Wedge data

15 Wedge keyboard enable

* Must be connected to CTS or hardware

handshake out on the computer.
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Connector Configurations

PT Dock

Figure F-3: PT Dock Pinouts

Pin #13

Pin #1

Pin #25

Table F-3: PT Dock Pinouts

Pin #14

1 No connection 14 Ground

2 No connection Reserved 15 No connection

3 No connection Reserved 16 No connection

4 485- Reserved 17 No connection

5 485+ Reserved 18 No connection

6 No connection 19 Serial handshake Controls received
out data

7 Keyboard interface 20 Serial data in Received data to

dock
8 Keyboard interface 21 Serial data out Transmitted data
from dock

9 No connection 22 No connection

10 No connection 23 +5V +5 volts in to dock

11 Serial handshake in Controls 24 No connection

transmitted data
12 Keyboard interface 25 Ground
13 Keyboard interface
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Programming Ba

This chapter provides bar codes for common setup parameters that ca
programming the PSC PT2000 and TopGun. Factory default settings

APPENDIX CONTENTS

Predefined Defaults....................
Code 39
Interleaved 2 of 5.....cvvvvvevinneeee.
Codabar .......coceeevevieeeeinnn. .
Code 93,
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Programming Bar Codes

Predefined Defaults

GO 1111111 e 1111111
* + - D8 EE »* * + - D2 EE =
seret DNV
SO LI —te
* + -D1EE = * + - CB8ETE =
Code 39
ENABLE
oo WIINARIOMUMOIN o= OGO AN O
* $ + $ - 98 8 1 EE = * $ + $ - 98 8 8 E E =
MINIMUM LENGTH
SO 111 1
* + -9 1 8 8§ EE = * + -8 1408ETE =
o (INNMENNOMANN = R0RACHAAHTAMTA
* + - 811 8 E E * * + - 81 5 8 E E *
SO 1T 11110
* + - 81 2 8 E E * * + - 81 6 8 E E *
S
* + - 81 3 8 E E *
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Code 39

MAXIMUM LENGTH

o]
o
o

ENABLE CHECKSUM

ol

SEND CHECKSUM

$

» 3

FULL ASCII MODE

» 3

ACCUMULATE MODE

» 3

- 82 1 8 EE *
- 82 2 8 EE «*
- 82 3 8 EE «*

$ - 8 3 1 EE =
$ - 8 4 1 EE =*
$ - 85 1 EE =
$ - 86 1 EE =

40

50

60

Off

*
*
*

il
il
il
il

- 82 4 8 EE «*
- 82 5 8 EE «*
- 82 6 8 EE *

$ - 8 3 8 EE «*
$ - 8 4 8 EE =
$ - 8 5 8 EE «*
$ - 8 6 § EE *

+

+

+

+
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Programming Bar Codes

ENABLE AIAG ALTERNATE CHECK DIGIT

* $ $ - 87 1 EE =« * §

Interleaved 2 of 5

$ - 8 7 8 EE =*

+ +

ENABLE

»$

MINIMUM LENGTH

2 |
I
N |

-
=X

$ - 988 1 EE =*

- 8 9 89 2 EE =«
- 8 9 96 EE =«
- 8 9 1 8 EE =«
- 8 9 2 8 EE =«

. |
. |
. |
. |

$ - 8 8 8 EE =*

- 8 9 38 EE =«
- 8 9 4 8 EE =«
- 8 9 58 EE =«
- 8 9 6 8 EE «*

+ +

W

[op)

N

g1

(o2}
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Interleaved 2 of 5

MAXIMUM LENGTH

10

20

30

*
*
*

- 8 A1 8 EE «*
- 8 A2 8 EE «*
- 8 A3 8 EE «*

*
*
*

- 8 A4 8 EE «*
- 8 A5 8 EE «*
- 8 A6 8 E E *

REQUIRED LENGTH (no default; overrides minimum and maximum settings)

2

10

*
*
*
*
*

12

-89 82 8 AN E E =*
- 8 9 %9 4 98 A8 4EE *
- 8 9 96 @8 A8 6 EE *
- 8 9 898 8 A8 8EE =

-89 18 8 A1 8 EE =

2

*
*
*
*
*

-89 12 8A12EE =
-8 91 489 A14EFE =
- 8916 8A16ETE =
- 8918 88A18ETE =

-8 92 8 8 A2 8 EE *
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Programming Bar Codes

ENABLE CHECKSUM

on WV~ o= NEORCHINMIARRAI
* $ + $ - 98B 1 E E =* * $ + $ - 98B Q E E =*
SEND CHECKSUM
SO T et 1
* $ + $ - 98 C 1 E E = * $ + $ - 98 C QR E E =*
USE LENGTHS 6 AND 14 ONLY (case code)
on WMV~ o= EORCHINRIMIRRAC
* $ + $ - 9§98 D1 EE = * $ + $ - 98D Q E E =*
Codabar
ENABLE
oo INVACUADARHEN o ONOTWRRAM AT
* $ $ - 2 98 1 E E = * $ $ - 2 98 8 E E =

+

+
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Codabar

MINIMUM LENGTH

os ([l
I
|
o |l

MAXIMUM LENGTH

I
N |
o |l

SEND STOP/START

» 3

- 21 8 4 EE =*
- 2118 EE =*
- 212 8 E E =*
- 213 8 EE «*

- 221 8 EE *
- 22 2 8 EE «*
- 22 3 8 EE «*

$ - 2 3 1 EE =

40

50

60

40

50

60

@]
=

*
*
*

*
*
*

+

- 21 4 98 EE =*
- 215 8 EE «*
- 216 8 EE «*

- 22 4 8 EE «*
- 22 5 8 EE «*
- 22 6 8 EE «*

$ - 2 3 8 EE =
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Programming Bar Codes

CONVERT CODABAR TO CLSI

* $ $ - 2 41 EE =«

Code 93

+

or [l
* $

$ - 2 48 EE *

+

ENABLE

»$

MINIMUM LENGTH

N |
I
|

$ - 2 C1EE =*

- 2DWwWZ2EE «*
- 2D 18 EE =«
- 2D 2 8 EE =«

+

or |l
* $

. |
. |
. |

$ - 2 CR8EE =*

- 2D 38 EE =«
- 2D 48 EE =«
- 2D 5 8 EE =«

+

W

N

g1
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UPC-A

MAXIMUM LENGTH

2 |
I

N |

UPC-A

- 2 E 8 2 EE *
- 2 E 1 8 EE *
- 2 E 2 8 EE «*

*
*
*

- 2 E 3 8 EE «*
- 2 E 4 8 EE «*
- 2 E 5 8 EE «*

ENABLE UPC-A

» 3

SEND SYSTEM DIGIT

» 8

SEND CHECK DIGIT

» 3

$ - 38 1 EE =
$ - 31 1 EE =*
$ - 32 1 EE =

$ - 38 8 EE =
$ - 31 8 EE =
$ - 32 08 EE =

+

+

+
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Programming Bar Codes

CONVERT UPC-A TO EAN-13

* $ $ - 33 1 EE =« * §

UPC-E

$ - 383 8 EE =*

+ +

USE SYSTEM DIGIT O

* $ $ - 341 EE =« * §
USE SYSTEM DIGIT 1

oo [WINIVINANANIN o W0
* $ $ - 351 EE =« * §
CONVERT UPC-ETO UPC-A
on  INNKMOARHONIN o (AW
* - 36 1 EE = *
SEND SYSTEM DIGIT
L
+ - 37 1EE » * - 37 8 EE »

I
*
$ - 38 1EFE * *$ + 8% - 3808EE *

SEND CHECK DIGIT
136 PT2000™ & TopGun™
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$ - 35 8 EE =*
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+ +

+

»$

+ +
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EAN/JAN

EAN/JAN

ENABLE EAN-8/JAN-8

» 3

ENABLE EAN-13/JAN-13

» 3

+

+

» 3

SEND CHECK DIGIT

» 3

+

+

AN
AN
CONVERT EAN-13 TO ISBN

$ - 3B 1 EE =
$ - 3 F 1 EE =*

+

* §
* §
* §
* §

+

+

+

$ - 3 9 8 EE =
$ - 3 ARQEE =
$ - 3B RV EE =
$ - 3 F ® EE =
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Programming Bar Codes

UPC/EAN/JAN Extensions

ALLOW 2-DIGIT EXTENSIONS

oo (IVAUNRHEN o ONOTORM AL
* $ + $ - 3 C 1 EE = * $ + $ - 3 C Q E E =
ALLOW 5-DIGIT EXTENSIONS
oo (IVAVIARHEN o ONCTRHRAT AT
* $ + $ - 3 D1 EE =* * $ + $ - 3D Q EE =
REQUIRE EXTENSIONS
on  WINVIANHNVARE o« ACORCHIMARIRARRAA
* $ + $ - 3 E 1 E E =* * $ + $ - 3 E Q E E =*
Code 128
ENABLE
on  (WIIVNAADAREN o OVOEHCAR AR AT
* $ $ - 49 1 EE =« * $ $ - 4 9 8 E E «»

+

+
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Code 128

MINIMUM LENGTH

N |
I
|
o |l

MAXIMUM LENGTH

I
N |
o |l

ENABLE UCC128

» 3

- 4182 EE »
- 41108 EE =
- 4128 EE =
- 413 08WEFE »

- 42 1 8 EE «*
- 42 2 8 EE «*
- 42 3 8 EE «*

$ - 43 1EE =

40

50

60

40

50

60

@]
=

*
*
*

*
*
*

+

- 41 4 8 EE «*
- 415 8 EE «*
- 41 6 8 EE «*

- 42 4 8 EE «*
- 42 5 8 E E «*
- 42 6 8 EE «*

$ - 4 38 EE =
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Programming Bar Codes

Other Controls

ENABLE MANUAL RESET

On

Off

*
*
*

AUTO-OFF (in minutes)

$ - B8 1 EE =*

- B2 898 EE «*
- B2 W5 EE «*
- B2 18 EE «*

INTERCHARACTER DELAY (in milliseconds)

0

10

25

*

*
*

E E =*

- B 3 8w

- B3 18 EE «*
- B 325 EE =«

o)

-
=X

30

60

90

50

75

99

*
*
*

*

*
*

+

$ - B 8EE *

- B2 38 EE «*
- B2 6 8 EE «*
- B2 9 8 EE «*

- B3 58 EE =«

- B 375 ETE =«
- B3 9 9 EE «*
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Other Controls

ADD CODE ID

On

=

B 5 1EE =*

NMBRIY e TN
NNNRMIN o 0
- B 88 2 EE «* *

* - B 9 8 1 EE = *
* - B 9 8 2 EE = *

GOOD-READ TONE DURATION (in seconds)

* - B AW®1ETE =*
* - B A8 8 EE =« *

B 58 EE =*

- B 8 8 5 EE «*
- B 88 7 EE «*

- B 9 8% 3 EE «*
- B 9 8% 4 EE *

- B AW3EE »
- BAWZ2EE *

GOOD-READ TONE

veawm ]
Low

GOOD-READ BEEPS
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Programming Bar Codes

BEEPER VOLUME

e 11111111 )1 11111
* + -BCOWGS8ETE = * + -BCWI1ETE =
ocerease|[||[1IMNMARMINIIAL e VAINVMRNIRRNIMANII
* + -BCWO9EE = * + -BCWZ7ETE =
O 11
* + -BCUWOWEE =*
ERROR TONE
RS 11110 LD
* + -BDUWI1EFE =* *$ +%-BDR WGT7EE »
e
* + -BDUWG4EE =*
KEYBOARD CLICK
oo |INNEMRARNMOANN o« JREDTVANTE IR
*$+$-DDI1EFE =* *$+$-DDU 8EE =*

+ +
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Clock and Calendar

Clock and Calendar

sarme (Il secome
* °/o - *

QLI e

$ - D8 8EE *

$ - D9 W8 EE

*

CLOCK FORMAT

szour [
* $

DATE FORMAT

us Il
* $

Serial Parameters

+

+

‘ International H“HH“H
* §

* % . %
$ - D8 1 EE =

$ - D 9 1 EE =

+

+

HOST SELECT (no default)

$ $ -Cw11EE
BAUD RATE

* - C 18 8 EE =

[MENOTII - -0
- C1 89 1EE =

AT, PS/2, or
compatible

‘ IBM
terminal

* +

+

+

*
*

+

+

+

$ - CHW815EE *

- C1 8 2 EE =
- C 189 3EE =
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Programming Bar Codes

4800

19,200

DATABITS

7

PARITY

None

Odd

STOP BITS

1

*
*
*

*
*

ENABLE XON/OFF

On

+

+

+

+

- C1 89 4 EE =«
- C1 895 EE =«
- C1 89 6 EE =«

$ - C2 08 7 EE =*

- C3 88 EE «*
- C3 89 3 EFE =«

$ - C 489 1 EE =*

+

$ - C51EE =*

saaoo [
reeoo [

- C1 89 7 EE =«
- C 189 8 EE =«

+

+

* $
* $

$ - C2 08 8EE =*
$ - C3 8 4EE =*

+

+

* $ +
* 3

$ - C 48 2 EE =*
$ - C5 8 EE *

+
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Serial Parameters

LINEFEED

nore  [[Jl]
Strip LF H““HM

PROTOCOL

EOR only H"“H”H
* $

- C6 8 8EE * * $
-C6 8 1EFE »

$ - CAQNBEE * *

CR with checksum and ACK/NAK response H"“‘ ”H

$ - C6 8 2 EE =

+ +

+

+

- CA 82 EE =*
- CA 8 1ETE =*

- CD 58 EE *
- CD 7 5 EE =«
- CD 9 9 EE =«

+

+

TIMEQOUT (in 100-millisecond units)

* - CDWY®WEE =*
* - CD 189 EE =
*

- CD 25 EE =«

a1

o [l
3 |
|

\l

(o}
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INDEX

$+$- in bar codes  4-64 starting 3-23

* (asterisk) in bar codes  4-64 asterisk (*) in bar codes  4-64

N (caret) in display screen  2-13 attaching portable to computer
I/Okey 2-12,3-19, 3-53 keyboard wedge configuration  3-21

serial configuration  3-49
attaching TopGun module to PT 2000 C-

A 100 to C-102
Auto-Off
accumulate option for Code 39 4-66 bar codes for  G-140
bar codes for  G-129 programming parameters for ~ A-90

[e0]

programming parameters for ~ A-88
adapter, power 3-50
AIAG check digit B
bar codes for  G-130

programming parameters for  A-88 backspace key 2-13
Alpha key 2-12 bar code symbologies 2-8
alpha mode 2-12 displaying 2-15
bar code for 4-58 bar codes for programming  4-58, G-127 to
applications see PALPRO G-145
ARE YOU SURE? message  3-48 creating  4-64 to 4-65
ASCII for date format  4-67
equivalents for serial characters  4-70 multiple  4-65
full (extended) 4-64, 4-66 for predefined defaults G-128
bar codes for G-129 for serial parameters  G-143 to G-145
programming parameters for ~ A-88 for setting date  4-67
values for keyboard keys  B-95 to B-96 for setting time  4-67
ASSETPRO  3-27 to 3-28 for time format  4-67
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Index

batteries E-115 to E-122
baud rate  4-68
bar codes for G-143 to G-144

default 5-74
programming parameters for  A-91
setting

in PDTFER  5-80
in PTFER  5-77, 5-78, 5-79
beeper 2-15
bar codes for  4-58, G-141 to G-142
programming parameters for -~ A-90
bits, data and stop  4-68
bar codes for G-144
default 5-74
programming parameters for ~ A-9
setting in PTFER  5-77
BKSP key 2-13
buttons see keypad

©

—

C

cables
keyboard wedge 3-21
serial  3-49

calendar see date and time
caret () in display screen  2-13

changing communications settings 5-76 to

5-77

character set, full (extended) ASCIl  4-64, 4-

66

bar codes for  G-129

programming parameters for ~ A-88
charging backup battery message E-121
check-in and check-out see TRACKPRO
checksum

Interleaved 2 of 5 4-66

protocol  4-68
cleaning the portable 3-55

clock see time and date
Codabar
bar codes for  G-132 to G-134
programming parameters for  A-88
Code 128
bar codes for  G-138 to G-139
programming parameters for ~ A-89
Code 39
accumulate option  4-66
programming parameters for  A-88
bar codes for  G-128 to G-130
equivalents for keyboard keys B-95 to B-9

full (extended) ASCII mode  4-64, 4-66
bar codes for  G-129
programming parameters for  A-88

programming parameters for ~ A-88

Code 93
bar codes for  G-134 to G-135
programming parameters for ~ A-88
collecting data  3-21 to 3-35
COM port  see port
command line options
for PDTFER 5-80
for PTFER  5-78 to 5-79
communications port see port
communications settings

changing 5-76to 5-77

Port options for 5-77

for PTFER 5-74

for updtfer 5-84

Communications Settings dialog box
(PTFER) 5-77
connector cables
keyboard wedge  3-21
serial  3-49
connector configurations F-123to F-126
conversion options  4-66, A-89
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Index

D

DO, D1, D2 (predefined defaults)
bar codes for  4-63, G-128
data

4-63, A-87

[&]

3-21to 3-3

collecting
deleting  3-48, 3-52 to 3-53
reviewing 3-47 to 3-48
transferring  5-71 to 5-84
from DOS 5-80
from a Macintosh ~ 5-81 to 5-82
from a UNIX workstation  5-83 to 5-84
from Windows 5-73 to 5-79
uploading  3-49 to 3-52
data bits  4-68
bar codes for
default 5-74
programming parameters for  A-9
data keys 2-11
date and time
bar codes for  G-143
programming parameters for ~ A-90
setting date  3-19 to 3-20, 4-67
setting time  3-19 to 3-20, 4-67
setting time format  4-67
default communications settings
for PTFER 5-74
for updtfer 5-84
defaults, predefined  4-63, A-87
bar codes for G-128
resetting  4-63
deleting data  3-48, 3-52 to 3-53
dialog boxes (PTFER)
Communications Settings  5-77
File to Receive  5-75
File to Transmit  5-76
display screen  2-13 to 2-15
caret (M) in  2-13

scrolling  2-1

G-144

—

dock (PT Dock)
connector configuration

dock (PT Dock) 2-16

dollar sign ($) in bar codes 4-64

DOS, transferring data from  5-80

downloading data from the portable 5-76

D-107 to D-113
F-126

E

EAN-13
converting from UPC-A  4-66, A-89
converting to ISBN  A-89
see also European Article Numbering
ENTER key 2-13
European Article Numbering (EAN)
bar codes for  G-137 to G-138
extensions  4-66, A-89, G-138

programming parameters for ~ A-89
see also EAN-13
extended ASCII character set  4-64, 4-66
bar codes for G-129
programming parameters for ~ A-88
extended keyboard support B-95 to B-96

extensions (UPC, EAN, and JAN) 4-66
bar codes for G-138

programming parameters for ~ A-89

F

FCC information  1-vii
file name, specifying for file transfer
in MACTFER 5-81, 5-82
in PDTFER  5-80
in PTFER  5-74, 5-76, 5-78
in updtfer 5-83
File to Receive dialog box (PTFER) 5-75

File to Transmit dialog box (PTFER) 5-76
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Index

file transfer, utilities for
MACTFER 5-72,5-81 to 5-82
PDTFER 5-72,5-80
PTFER 5-72,5-73 to 5-79
updtfer 5-72, 5-83 to 5-84
full (extended) ASCIl mode  4-64, 4-66
bar codes for  G-129
programming parameters for  A-88
full keyboard support B-95 to B-96
function keys 2-12

G

getting started quickly 1-4to 1-5

H

handshaking, Xon/Xoff 4-68

input device, attaching to PT 2000 3-18
intercharacter delay

bar codes for  G-140

programming parameters for ~ A-90
interface cables

keyboard wedge  3-21

serial  3-49
Interleaved 2 of 5

bar codes for  G-130to G-132

checksum  4-66

programming parameters for  A-88
introduction 1-2to 1-3
inventory tracking see INVPRO
INVPRO 3-29t0 3-32

starting 3-23

ISBN, converting from EAN-13  A-89
bar codes for  G-137

J

Japan Article Numbering (JAN)
bar codes for G-137 to G-138
extensions  4-66, A-89, G-138
programming parameters for ~ A-89

K

keyboard keys, programming B-95 to B-96
keyboard wedge 3-21 to 3-23

cables for  3-21

installing  3-21to 3-22

uploading data  3-51

keypad 2-10to 2-13

function keys 2-12

I/0 (on/off) key  2-12, 3-19, 3-53

modes 2-12

on/off (1/0) key 2-12, 3-19, 3-53

scrolling keys  2-1

L

laser see TopGun module

M

Macintosh computers, transferring data
from 5-81 to 5-82
MACTFER 5-72, 5-81 to 5-82
message
ARE YOU SURE?  3-48
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charging backup battery E-121
PROGRAM FAILED 4-58, E-120
Microsoft Windows, transferring data
from 5-73to5-79
module (TopGun) 2-10, C-99 to C-105
attaching to PT 2000 C-100 to C-102
changing orientation of  C-103
product labeling C-105
specifications C-105
multiple bar codes
accumulate option for  4-66
programming parameters
creating 4-65

A-88, G-129

N

normal mode 2-1

bar code for -5

o0 IN

O

selecting an application  3-23
switching applications  3-26
TRACKPRO  3-32to 3-53
parameters see programming parameters
parity 4-68
bar codes for
default 5-74
programming parameters for  A-91
setting in PTFER  5-77
password  3-20, 3-26
PDPROG 4-62
PDTFER 5-72,5-80
Percon Portable Programmer  4-59 to 4-61
Percon Program Generator (PPG) 2-9, 4-58
PERCPROG 4-59to 4-61
pin assignments  F-123 to F-126

G-144

port

default 5-74

setting
in PDTFER  5-80
in PTFER  5-77,5-78

Port options in Communications Settings
dialog box 5-77

on/off (1/0) key  2-12, 3-19, 3-53 Portable Applications Library (PAL) 2-9, 4-
options see programming parameters 59
orientation of TopGun module, power adapter  3-50
changing C-103 PPG 2-9,4-58
predefined defaults 4-63, A-87
bar codes for  G-128
F) product labeling for TopGun module  C-105
PROGRAM FAILED message 4-58, E-120
PAL (Portable Applications Library) 2-9, 4- program titles, changing  3-25
59 programming
PALPRO 3-23to 3-53 bar codes for  4-58, G-127 to G-145
ASSETPRO  3-27to0 3-28 predefined defaults A-87
changing program titles 3-25 bar codes for G-128
changing prompts  3-25 see also programming parameters
INVPRO  3-29 to 3-32 programming parameters  A-85 to A-91
Options menu  3-20, 3-22, 3-23, 3-26 general  4-66 to 4-67, A-88 to A-90
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predefined defaults  4-63, A-87
bar codes for G-128
serial  3-50, 4-68 to 4-70, A-91
programming utilities  4-59 to 4-62
programs see PALPRO
prompts, changing  3-25
protocol
default 5-74
programming parameters for  A-91
Xmodem  4-68
PT 2000
about 2-7to2-16
attaching input device to  3-18
attaching to computer
keyboard wedge configuration  3-21
serial configuration  3-49
attaching TopGun module to
102
bar codes for programming  4-58, G-127 to
G-145
creating  4-64 to 4-65
multiple  4-65
batteries E-115to E-122
cleaning 3-55
connector configurations F-123 to F-126
default communications settings 5-74
downloading data from
using PTFER  5-76
see also file transfer, utilities for
predefined defaults 4-63
bar codes for G-128
resetting 3-54
bar code for  4-58
serial parameters  3-50
symbologies read by 2-8
displaying 2-15
turningon  3-19
turning on off  3-53
uploading data from

C-100to C-

using PTFER  5-74 to 5-75
see also file transfer, utilities for
PT Dock 2-16, D-107 to D-113
connector configuration  F-126
PTFER 5-72,5-73to0 5-79
command line options  5-78 to 5-79
communications settings  5-74
changing 5-76 to 5-77
dialog boxes
Communications Settings  5-77
File to Receive 5-75
File to Transmit 5-76

Q

quick-start guide

1-4t0 1-5

R

random-access memory (RAM)  3-17
displaying 2-15

registration card 1-4

resetting the portable 3-54

bar code for  4-58

reviewing data  3-47 to 3-48
screen (display) 2-13to 2-15

scrolling  2-14
selecting a PALPRO application  3-23
serial cable
attaching  3-49
uploading data  3-49
serial characters, Code 39 and ASCI|
equivalents  4-70
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serial communications

bar codes for  G-143 to G-145

parameters for  A-91
serial port see port
serial programming parameters

4-70, A-91

bar codes for  G-143 to G-145
setting a password  3-20
setting time and date  3-19 to 3-20, 4-67
stop bits  4-68

default 5-74

programming parameters for  A-91

setting in PTFER  5-77
switching PALPRO applications
symbologies 2-8

displaying 2-15

-50,4-68to

0
N
[e)]

T

time and date
bar codes for  G-143
programming parameters for ~ A-90
setting date  3-19 to 3-20, 4-67
setting time  3-19 to 3-20, 4-67
setting time format  4-67
timeout
programming parameters for  A-91
setting in PDTFER  5-80
setting in PTFER  5-78
titles of PALPRO programs, changing 3-2
TopGun
about 2-9
attaching to computer
keyboard wedge configuration  3-21
serial configuration  3-49
bar codes for programming  4-58, G-127 to
G-145
creating  4-64 to 4-65

(6]

multiple  4-65
batteries E-115 to E-122
cleaning 3-55
connector configurations F-123 to F-126
default communications settings  5-74
downloading data from
using PTFER  5-76
see also file transfer, utilities for
module see TopGun module
predefined defaults 4-63
bar codes for G-128
resetting 3-54
bar code for  4-58
serial parameters  3-50
symbologies read by  2-8
displaying 2-15
turning off  3-53
turningon  3-19
uploading data from
using PTFER  5-74to 5-75
see also file transfer, utilities for
TopGun module 2-10, C-99 to C-105
attaching to PT 2000 C-100to C-102
changing orientation of C-103
product labeling C-105
specifications C-105
tracking assets see ASSETPRO
tracking inventory see INVPRO
TRACKPRO 3-321t0 3-53
starting 3-23
transferring data
from a Macintosh  5-81 to 5-82
from a UNIX workstation 5-83 to 5-84
from the DOS command line  5-80
from Windows 5-73 to 5-79
turning the portable on and off  3-19, 3-53

5-71t0 5-84
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U

Universal Product Code (UPC)
conversion options  4-66, A-89
extensions  4-66

bar codes for G-138
programming parameters for ~ A-89
see also UPC-A and UPC-E

UNIX workstations, transferring data

from 5-83to5-84

UPC-A
bar codes for G-135 to G-136

converting from UPC-E  4-66, A-89
converting to EAN-13  4-66, A-89
programming parameters for ~ A-89

UPC-E
bar codes for G-136
converting to UPC-A  4-66, A-89
programming parameters for ~ A-89
updtfer 5-72,5-83 to 5-84
uploading data  3-49 to 3-52, 5-74 to 5-75
utilities
MACTFER 5-72, 5-81 to 5-82
PDTFER 5-72,5-80
PTFER 5-72,5-73to 5-79
updtfer 5-72, 5-83 to 5-84
utilities for programming  4-59 to 4-62

V

version number, displaying 2-15
virtual display — 2-13 to 2-15

W

Windows, transferring data from  5-73 to 5-
79

X

Xmodem protocol  4-68
Xon/Xoff 4-68
programming parameters for ~ A-91

Z

“zap” character B-94
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DECLARATION OF CONFORMITY

Caosc

PSC Inc. hereby declares that the equipment specified below
has been tested and found compliant to the following directives and standards —

Directives: EMC 89/336/EEC
Low Voltage 73/23/EEC
R&TTE 1999/5/EC

Standards
Equipment: EN 55022-A&B:1994/1998, EN 50082-1:1992/1998
EN 55024:1998, EN 60825-1:1996, EN 60950:1998
Power Supplies:  EN 55014-1/2:1993/1997, EN 61558-1:1997
EN 61558-2-6:1997
Radios: ETS 300 328:1995/1996, EN 300 826:1997
EN 301.489.1/17:2000, EN 60950:1992+A4

Equipment Type:  Portable Data Terminal Equipment

Product:  Falcon Family Models 31X, 32X, 33X, 34X, 51X, Single
Dock Station, 4-Slot Dock Station, and PT2000

Brad West Peter Lomax

Vice President Vice President

Quality and Process Manage- Europe, Middle East & Africa
ment PSC Bar Code Ltd.

PSC, Inc. Axis 3, Rhodes Way

959 Terry Street Watford

Eugene, OR 97402 Hertfordshire WD24 4TR
US.A.

e
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Asia Pacific

PSC Hong Kong

Hong Kong

Telephone: [852]-2-584-6210
Fax: [852]-2-521-0291

Australia

PSC Asia Pacific Pty Ltd.

North Ryde, Australia
Telephone: [61] 0 (2) 9878 8999
Fax: [61] O (2) 9878 8688

France

PSC S.AR.L.

LES ULIS Cedex, France
Telephone: [33].01.64.86.71.00
Fax: [33].01.64 46.72.44

Germany

PSC GmbH

Darmstadt, Germany

Telephone: 49 (0) 61 51/93 58-0
Fax: 49 (0) 61 51/93 58 58

Italy

PSC S.p.A.

Vimercate (MI), Italy
Telephone: [39] (0) 39/62903.1
Fax: [39] (0) 39/6859496

Japan

PSC Japan K.K.
Shinagawa-ku, Tokyo, Japan
Telephone: 81 (0)3 3491 6761
Fax: 81 (0)3 3491 6656

Latin America

PSC S.A., INC.

Miami, Florida, USA
Telephone: (305) 539-0111
Fax: (305) 539-0206

United Kingdom

PSC Bar Code Ltd.

Watford, England

Telephone: 44 (0) 1923 809500
Fax: 44 (0) 1923 809 505

Caosc

www.pscnet.com

PSC Inc.

959 Terry Street

Eugene, OR

Telephone: (541) 683-5700
Fax: (541) 345-7140

R44-2249 (Rev C) 2/04

©2002 PSC INC.
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